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NCDOT CONGESTION MANAGEMENT SIMULATION GUIDELINES - 1 

TRANSMODELER 2 

This document provides standards to ensure consistent traffic analysis done by/for the North Carolina Department 3 

of Transportation (NCDOT) Congestion Management Section using TransModeler traffic simulation software.  The 4 

utilization of advanced traffic simulation software requires an understanding of traffic engineering principles and 5 

the ability to make sound engineering judgments.  In certain circumstances, deviation (within certain parameters 6 

defined in these guidelines) from these guidelines will, may, or will not be allowed.  Within this document, the 7 

term shall defines parameters that cannot be modified without prior approval from the NCDOT Congestion 8 

Management Section. Additionally, the term should is utilized where any deviation from these guidelines or any 9 

default parameter requires justification and documentation.  The term may represents conditions that are at the 10 

discretion of the analyst. The information and guidance included in these Guidelines is neither all inclusive, nor 11 

should they be considered to be completely rigid.  The intent of these Guidelines is to provide reasonable bounds 12 

for developing simulation studies in a consistent manner, but remain flexible enough to handle unique situations 13 

when warranted, properly justified and fully documented.  The goal of utilizing advanced simulation is to provide 14 

the most realistic analysis possible. It is the responsibility of the analyst preparing the models to develop them in 15 

a manner that is technically sound. The flexibility allowed in these Guidelines should be utilized, when needed, to 16 

meet this goal.  Strict adherence to the Guidelines shall not be used as an explanation as to why something was, 17 

or was not, done during the development of an analysis.  By reviewing reports, plans, and submittals, the NCDOT 18 

in no way relieves the analyst of possible claims or additional work resulting from errors or omissions. 19 

This version of the Guidelines shall apply to all projects that have a Notice to Proceed issued after the Effective 20 

Date listed in the footer of this document. 21 

These Guidelines were developed for projects being completed for the NCDOT Congestion Management Section 22 

and include requirements that deviation from these Guidelines be approved.  These Guidelines are limited to 23 

capacity analysis studies only, detailed operational studies, such as field signal timing may have different 24 

requirements.  These Guidelines may be utilized for projects that are not being prepared for the NCDOT 25 

Congestion Management Section, such as projects at the Division level, at the discretion of the responsible NCDOT 26 

Business Unit.  For Non-Congestion Management Section projects, substitution of the responsible NCDOT Business 27 

Unit throughout these Guidelines where NCDOT Congestion Management Section approval is required is 28 

acceptable. 29 

FILE SETUP 30 

This section includes a summary of the NCDOT default files and settings for TransModeler modeling.  It also 31 

includes guidelines for folder and file naming for all modeling projects. 32 

Default File – Project Archive 33 

The NCDOT Default TransModeler database (current version: NCDOT_Default_09-2016.zip) is available from the 34 

Congestion Management Section website (https://connect.ncdot.gov/resources/safety/Pages/Congestion-35 

Management.aspx). The default file is a zip file that was created as a Project Archive in TransModeler and includes 36 

the default parameters for projects being analyzed by NCDOT. 37 

The zip file that includes the project archive shall be downloaded and extracted to the appropriate project folder 38 

prior to developing the model. 39 

https://connect.ncdot.gov/resources/safety/Pages/Congestion-Management.aspx
https://connect.ncdot.gov/resources/safety/Pages/Congestion-Management.aspx
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Default File – Project Preferences 40 

In TransModeler, there are a wide variety of preferences for controlling the map and layer styles, default project 41 

settings, and other options within simulation databases.  The NCDOT Default Project Preferences file 42 

(tsm_user.xml) is available from the Congestion Management Section website 43 

(https://connect.ncdot.gov/resources/safety/Pages/Congestion-Management.aspx). These preferences are 44 

included under >Project>Preferences for TransModeler.  The project preferences are utilized in TransModeler SE; 45 

however, the dialog box to modify preferences is not available in TransModeler SE. 46 

The Project Preferences generally are settings that do not affect the actual operations of the model; therefore, 47 

their use is recommended, but not mandatory. 48 

To utilize the NCDOT default project preferences the tsm_user.xml file must be copied into the directories, where 49 

the user text is replaced by the Windows User Name on the computer utilizing the software. 50 

TransModeler  C:\Users\user\AppData\Roaming\Caliper\TransModeler 4.0\tsm_user.xml  51 

TransModeler SE  C:\Users\user\AppData\Roaming\Caliper\TransModeler SE 4.0\tsm_user.xml 52 

Note: the AppData folder may be hidden in Windows. 53 

The list of default preferences modified in the Project Preference file are included in Attachment A.  54 

Default File – NCDOT Default Parameters 55 

TransModeler includes a default set of global model and driver behavior parameters that apply to all simulation 56 

projects.  NCDOT is currently developing a set of parameters that are representative of the general traffic 57 

operations experienced in North Carolina that can be used as default parameters in simulation.  Until this 58 

evaluation is completed, a set of NCDOT defaults has been developed based on the existing experience in using 59 

TransModeler and shall be utilized for all simulation projects.  It is not possible to create one set of parameters 60 

that will be valid for all projects across the state; however, the default parameters should provide a good starting 61 

point for developing a model.  Modification of the default parameters is discussed in detail in the Visual Validation 62 

and Calibration sections of these guidelines. 63 

The NCDOT Default Parameter files were developed based on the terrain of the project (level, rolling or 64 

mountainous) and shall be utilized based on the terrain within the project study area being modeled. The terrain 65 

for the project study area shall be based on the definitions included in the latest version of the AASHTO Policy on 66 

Geometric Design of Highways and Streets.  If grades are not being utilized, the level terrain parameters file shall 67 

be used. 68 

The list of default parameters modified in the NCDOT Default Parameters file are included in Attachment A.  69 

Folder Naming Conventions 70 

TransModeler is based on a Geographic Information System (GIS); therefore, it has a large number of files 71 

associated with each simulation project.  Prior to September 2016, most projects were developed with all of the 72 

analysis files included in a single folder.  While this is still acceptable, especially for models developed prior to 73 

September 2016, the desire is now to have a more orderly folder structure.   74 

Each unique model developed in TransModeler shall be included in its own separate set of folders. The 75 

TransModeler model files shall be placed in a folder with the following naming standard: 76 

 {TIP or Project No.}_{Analysis Year or Years}_{Scenario}_{Alternative (if applicable)} 77 

https://connect.ncdot.gov/resources/safety/Pages/Congestion-Management.aspx
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 With: 78 

  TIP or Project No.:  STIP, Special Project (SP) or SPOT ID 79 

Analysis Year or Years: Analysis Year for Model or Years if multiple analysis years are included in 80 

a single model 81 

Scenario: No-Build, Build or some other special scenario 82 

Alternative: Alternative name/number or additional information to distinguish between differing 83 

options or scenarios 84 

 For Example:  U-0000_2016_No-Build 85 

   R-0000_2016-2040_No-Build 86 

   I-0000_2040_Build_Alternative 1 87 

Within the model folder, subfolders are included with the following names and descriptions: 88 

 Database  TransModeler database (.dbd) and associated files 89 

Input Files  Model input files listed under >Project Settings>Input>Input Files, including signals, 90 

pedestrians (if applicable) and turn prohibitions (if applicable) 91 

Input Volumes  Volume input files (.mtx for matrix or .bin for turning movements). Includes AM and PM 92 

subfolders 93 

Output   Output data from simulation runs.  Includes AM and PM subfolders 94 

 Parameters  Default Parameters file (.xml) based on terrain 95 

Routing  Dynamic traffic assignment and historic routing files, if applicable.  Includes AM and PM 96 

subfolders. 97 

File Naming Conventions 98 

Once completed, all model files developed in TransModeler will be stored in a database and will be made available 99 

for future analysis efforts.  Therefore, they need to be developed in a manner that allows them to be easily 100 

followed for any future analyst who may need to work with the model.  101 

The following are the required naming conventions for each file: 102 

 Simulation Project File (.smp) shall have the same name as the overall simulation folder described above 103 

in the folder naming conventions: 104 

 {TIP or Project No.}_{Analysis Year or Years}_{Scenario}_{ Alternative (if applicable)}.smp 105 

 Simulation database (.dbd) and associated files shall have the same name as the .smp file 106 

 Turning Movement files (.bin) shall have the same name as the .smp file with “_TMC” appended, along 107 

with any additional information or descriptors, following the Alternative portion of the file name 108 

 Matrix files (.mtx) shall have the same name as the .smp file with any additional information appended 109 

following the Alternative portion of the file name.  Any matrices used for the warm-up period shall have 110 

“_warmup” appended to the file name to designate them as warmup period matrices. 111 
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 Input files (Signals, Incidents, Pedestrians, Detour Paths, Turn Prohibitions) shall follow the same file 112 

naming convention as the .smp file with any additional information appended to the end of the file name. 113 

 Routing files (Historical and Turning Delay) shall follow the same file naming convention as the .smp file 114 

with “_Historical” and _Turning Delay” appended, along with any additional information (such as AM and 115 

PM), to end of the file name. 116 

 Parameters files (.xml) shall maintain the same name as in the Project Archive 117 

(NCDOT_Default_Parameters_Date_Terrain.xml).  However, if any default parameters are modified due 118 

to visual validation or calibration the file should be renamed with the _Default_ portion of the file name 119 

modified to the TIP or Project Number and the _Date_ portion updated to the date of the modification.  120 

For example, if a model for U-0000 modified default parameters in December 2016, the file would be 121 

renamed: NCDOT_U-0000_Parameters_12-2016_Level.xml 122 

 Project Archives (.zip) shall follow the same file naming convention as the .smp file with the date of the 123 

archive appended to the end of the file name.  124 

PROJECT SETTINGS 125 

In order to simulate traffic, TransModeler requires a variety of input files and parameters for each scenario in a 126 

project.  The Project Settings dialog box (>Project>Settings) includes several tabs that should be reviewed and 127 

properly configured for each scenario being modeled.  A single simulation project can include multiple scenarios 128 

as long as they all have the same simulation network.  For example, a 2016 Existing and 2040 No-Build analysis 129 

could be completed with a single simulation file, if there are no changes in the network, with AM and PM scenarios 130 

being included for each analysis year.    Typically, each simulation project will include both the AM and PM analyses 131 

in a single file with each peak period being an individual scenario.   132 

The naming convention for scenarios follows a similar structure as the file naming conventions described earlier:  133 

{TIP or Project No.}_{Analysis Year or Years}_{Scenario}_{Alternative (if applicable)}_{Time Period (AM/PM)} 134 

For example: U-0000_No-Build_2016_AM or R-0000_Build_2040_Alternative 3_PM 135 

Setup Tab 136 

The information included on the Setup tab establishes the basic project scope, including information such as the 137 

start and end time of the simulation.  For all simulation projects, the Warm-up Period should be determined to be 138 

the greater of either 15 minutes or the expected travel time for the longest path within the model.  Each scenario 139 

shall include a Warm-up Period followed by a one-hour period for simulation with the AM peak simulation hour 140 

being from 8:00-9:00 AM and the PM peak simulation hour being from 5:00-6:00 PM.  Therefore, the Simulation 141 

Period Start Time shall be set to a time prior to 8:00 AM or 5:00 PM equal to the Warm-up Period duration.  The 142 

Simulation Period End Time for single hour simulation projects shall end at 9:00 AM or 6:00 PM.  The Initial State 143 

settings shall be set to Empty and the Warm-up Period described above shall be included.  Under the Show 144 

Optional Project Settings, the Routing and Parameters options shall both be selected. 145 

Network Tab 146 

The network tab includes the information about the network database in TransModeler and allows the turning 147 

movement database file (.dbd) to be defined.  The Road Network – Database field shall include the project 148 

database including the proper folder and file naming conventions.  The Turning Movement Variables – Table field 149 

should define the turning movement data for any project utilizing turning movements to optimize isolated signals. 150 
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Input Tab 151 

The input tab includes the most common input files to the simulation analysis.  The Trip Tables shall include either 152 

the input O-D matrix (.mtx) volume files or the input Turning Movement Files (.bin) that are to be utilized to 153 

simulate traffic during the model runs.  The use of O-D matrices or Turning Movement Volumes is discussed in 154 

further detail in the Volume Input section. 155 

Additionally, the input files for signals and, if applicable, the Incidents, Pedestrians, HOT Lanes, Detour Paths and 156 

Turn Prohibitions shall be included on the Input tab. 157 

Output Tab 158 

The output tab determines which raw output statistics are to be collected in each model run.  For additional 159 

information on outputs, please see the Measures of Effectiveness section. 160 

Routing Tab 161 

The routing tab includes the inputs and settings to the route choice model utilized in the simulation.  The default 162 

settings for Route Choice include the Method being set to Stochastic Shortest Path and the options for Use Turning 163 

Delays, Enforce Free Flow Travel Time as Minimum and Enforce Global Turning Delays as Minimum being selected. 164 

For projects that utilize Dynamic Traffic Assignment (DTA), the Travel Time and Turn Delay fields for Historical and 165 

Turning delay shall be utilized.  For additional information on DTA and Routing please see the Dynamic Traffic 166 

Assignment section. 167 

Global Turning Delays shall be set to 10 seconds for right turns, 0 seconds for through, 15 seconds for left turns 168 

and 20 seconds for U-turns. 169 

Parameters Tab 170 

The parameters tab includes the definition of the parameters file that sets the global model and driver behavior 171 

parameters that apply to the simulation project. The Model Parameters – Parameters field shall include the 172 

appropriate NCDOT_Default_Parameters file (.xml) based on the terrain of the project.  If the project includes 173 

visual validation where parameters are modified, the modified parameters file (renamed with the proper naming 174 

convention) shall be attached.  The default step size shall be set to 0.1 seconds for microscopic simulation. 175 

Options Tab 176 

The options tab includes several options that do not have any effect on the simulation and the default values 177 

should be maintained. 178 

MODEL DEVELOPMENT 179 

This section includes the guidelines for developing models in TransModeler. 180 

Background for Model Development  181 

The development of models is typically done utilizing aerial imagery for existing conditions models and GIS 182 

shapefiles for proposed designs.   183 

There are several sources and methods for utilizing aerial imagery in TransModeler, including: 184 

 NC OneMap  high resolution aerial imagery collected on a rotating basis every three years.  The data 185 

can be downloaded and utilized at any time without a network connection.  Once the files are downloaded 186 

they can be stored locally on a computer or server and referenced into the model. Available at: 187 

http://data.nconemap.gov/geoportal/catalog/raster/download.page  188 

http://data.nconemap.gov/geoportal/catalog/raster/download.page
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 Web Map Layer  TransModeler includes commercially available aerial imagery as Web Map Layers that 189 

can be accessed with a network connection.  The map layers include maps and imagery from Google, 190 

OpenStreetMap, USGS and Virtual Earth.  The imagery is available in TransModeler through the 191 

>Tools>Imagery>Web Map Layers menu and on the >Tools>Toolbar>Web Map Layers Toolbar for 192 

TransModeler SE. 193 

 Project Specific Aerials  If project specific aerials are available in a standard imagery format, they shall 194 

be attached in a coordinately correct manner.   195 

In addition to the ability to download NC OneMap imagery, the aerial image data is available with a pair of custom 196 

Web Map Layer settings files (NCOneMap(Latest)High.xml and NCOneMap(Latest)Low.xml) that are available 197 

from the Congestion Management Section website 198 

(https://connect.ncdot.gov/resources/safety/Pages/Congestion-Management.aspx). To be available in the list of 199 

Web Map Layers in TransModeler and TransModeler SE, the files must be copied into the following directory:  200 

TransModeler  C:\Users\user\ My Documents\Caliper\TransModeler 4.0\WebMapServices\ 201 

TransModeler SE  C:\Users\user\ My Documents\Caliper\TransModeler SE 4.0 \WebMapServices\ 202 

Background data files are attached to the model as layers.  If a model is being developed in TransModeler and 203 

includes more than ten image files, they should first be included in an image library (.cil) file developed using the 204 

image librarian toolbox under >Tools>Imagery>Image Librarian> and not be attached directly to the model as 205 

individual layers.  This ability to create .cil files is not available in TransModeler SE; therefore, if the project is 206 

developed inTransModeler SE and has more than 10 image files, it is acceptable to attach them as layers. 207 

Design Data in Microstation or AutoCAD format must first be exported to a supported file type before being 208 

referenced into TransModeler as a layer.  Two methods are available for importing design data into TransModeler: 209 

 ESRI Shapefile (.shp) attached as a layer to your model 210 

 Microstation V7 file (.dgn) converted to a .dbd file 211 

An ESRI Shapefile (.shp) is the most common file type for referencing design data into TransModeler.  However, a 212 

Microstation design file may be saved as a V7 file in Microstation and then opened (>File>Open) in TransModeler.  213 

The file then may be saved as a .dbd database file and can be added as a layer to the model. 214 

TransModeler is a geographic information system (GIS) based program and operates based on latitude/longitude; 215 

therefore, design data should be imported/exported with the following settings: 216 

 Coordinate System Class: North America NAD83 (US State Plane) 217 

 Coordinate System Zone: 3200: North Carolina 218 

 Unit Conversion – Interpret as Units: Feet 219 

 Datum Conversion Method: No Change 220 

Merging Previously Developed Models 221 

One of NCDOT’s primary goals for TransModeler is to be able to utilize previously developed models and not re-222 

create the model networks each time an area is modeled.  NCDOT Congestion Management Section is in the 223 

process of developing a GIS layer and database of all of the completed TransModeler models in North Carolina.  224 

Until this is fully operational, the analyst shall check with the appropriate NCDOT Congestion Management Section 225 

staff member to determine if existing models are available for the project study area.  226 

https://connect.ncdot.gov/resources/safety/Pages/Congestion-Management.aspx
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If an existing model is available, the previous model database (.dbd file) and signal plan data (.tms file) shall be 227 

merged into a single model database and signal plan with the same file name as the new model.  The merged data 228 

should then be copied into the project directory, overwriting the previous data, such that all of the settings in the 229 

simulation project file (.smp file) are maintained.  230 

Fiscal Constraint for Future Year Models 231 

When developing future year models, the analyst shall review the pertinent plans listed below to determine if any 232 

additional reasonably foreseeable projects, beyond the subject project being modeled, are located within the 233 

model study area.  Any project that is reasonably foreseeable should be included in the future year model(s).  The 234 

following criteria shall be used to determine if a project is reasonably foreseeable: 235 

 For model study areas located within the boundaries of a Metropolitan Planning Organization (MPO), the 236 

currently adopted Long Range Transportation Plan (LRTP) or Metropolitan Transportation Plan (MTP) shall 237 

be reviewed to determine if any projects within the model study area are included on the fiscally 238 

constrained list of projects.  These projects shall be included in the analysis. 239 

 For a non-MPO area, any project located within the model study area that has construction funding in the 240 

current State Transportation Improvement Program (STIP) shall be included in the analysis. 241 

Link Coding 242 

Road Class 243 

In TransModeler, each link is assigned a road class that distinguishes different types of facilities by basic traffic 244 

flow parameters. All links in a model shall be coded with the appropriate Road Class.  NCDOT has developed a 245 

custom set of Road Classes (included in Attachment B) that are based on the facility type and speed limit. The 246 

selection of the Road Class should be based on the NCDOT Functional Classification Map 247 

(http://ncdot.maps.arcgis.com/home/webmap/viewer.html?layers=029a9a9fe26e43d687d30cd3c08b1792).  248 

The following facility types and their corresponding functional classification are available in the Road Class library: 249 

 Freeway  Interstate and Other Freeway  250 

 Directional Ramp, Ramp and Loop 251 

 Arterial  Other Principal Arterial and Minor Arterial 252 

 Collector  Major Collector and Minor Collector 253 

 Local  Local 254 

 Roundabout 255 

 Arterial_DDI 256 

For Freeways, Arterials, Collectors and Local roadways, the Road Class should be selected based on the posted 257 

speed limit of the facility.  For roadways that do not have a posted speed limit, an appropriate speed limit should 258 

be selected and documented in the model documentation. 259 

Directional Ramps should be used whenever a ramp is making a high speed (non-loop) freeway to freeway 260 

connection and the default speed limit should be 50 mph.  If detailed design information is available, then 261 

deviation from the default speed is acceptable, if properly documented in the model documentation. 262 

The Ramp road class should be used for non-freeway to freeway ramp connections and the default speed limit 263 

should be 45 mph.  If detailed design information is available, then deviation from the default speed is acceptable, 264 

if properly documented in the model documentation. 265 

http://ncdot.maps.arcgis.com/home/webmap/viewer.html?layers=029a9a9fe26e43d687d30cd3c08b1792


DRAFT – Effective Date: October 01, 2016   Page 8 of 55 

The Loop road class should be used for all loop connections along a freeway and the default speed limit should be 266 

25 mph.  If detailed design information is available that indicates different design speeds, then deviation from the 267 

default speed is acceptable, if properly documented in the model documentation. 268 

In order to properly develop Measures of Effectiveness for freeways, TransModeler requires that all connections 269 

between the Freeway Road Class and the Arterial, Collector and Local Road Classes include a transition roadway 270 

with a Directional Ramp, Ramp or Loop Road Class.  Therefore, all freeway facilities shall be modeled with 271 

appropriate transitional ramp elements.  If a facility operates as an Expressway with only limited control of access 272 

and lower speed (non-ramp or loop) access points, then it should be modeled with the Arterial Road Class. 273 

All Roundabouts shall be coded with the circulatory roadway having the Roundabout Road Class.  For single lane 274 

roundabouts with an inscribed diameter less than 120 feet, the default speed limit should be 20 mph while the 275 

default speed limit for an inscribed diameter of 120 feet or more should be 25 mph. If detailed design data is not 276 

available for roundabouts, single lane roundabouts should have an inscribed diameter of 120 feet and multi-lane 277 

roundabouts should have an inscribed diameter of 150 feet, 278 

The operations of Diverging Diamond Interchanges (DDI) differ slightly from those of standard arterials or collector 279 

roadways in that drivers tend to exhibit a more uniform speed distribution that does not deviate substantially 280 

from the posted speed within the DDI interchange.  Therefore, it is recommended that all DDI’s be coded with the 281 

Arterial_DDI Road Class with the Road Class speed limit being selected based on the geometry of the DDI and 282 

should be included in the model documentation.  Consideration should be given to the crossing angle of the DDI 283 

and the design speed with which drivers are able to navigate the design, which is frequently less than the posted 284 

speed of the adjacent facility. 285 

It should be noted that the use of the Functional Classification Maps is relatively new and that models developed 286 

previously were likely not developed based on these criteria; therefore, any previously developed model being 287 

utilized shall be reviewed and updated according to the guidance provided above.  Additionally, models developed 288 

prior to July 2015 may include Road Classes defined based on a previous naming convention.  Before merging a 289 

model into the default file, the analyst should update the road classes in the previous model to the current 290 

definitions and remove the old road classes from the file.  This can be accomplished by: 291 

1. Adding a new column to link Dataview and then copying the Road Class field into that column 292 

2. Changing all of the road classes to undefined (using fill command) 293 

3. Delete all of the existing road classes from the >Parameters>Edit Road Class dialog box 294 

4. Import the existing road class file Road Class Definitions.xml file 295 

5. Update the road classes for each link based on the attributes from the previous model 296 

If the model network includes a roadway that does not match any of the default Road Classes, then a new Road 297 

Class should be added with appropriate settings and documented in the model documentation.  For new Road 298 

Class definitions, the Desired Speed Distribution should be set based on the most similar default Road Class. 299 

Desired Speed Distributions 300 

The Desired Speed Distributions in TransModeler reflect the reality that not all vehicles travel at the same speed.  301 

Therefore, a distribution of speeds must be used that reflect the generalized driving conditions across the State.  302 

For these Guidelines, four speed distributions were developed based on engineering judgment and a relatively 303 

small sample of spot speed data.  The four speed distributions include a standard distribution; a freeway 304 

distribution, where drivers tend to drive 5-10 mph over the speed limit; a high-compliance distribution, where 305 

drivers tend to drive closer the posted limit or are limited by geometry such as on a loop ramp; and a low-306 

compliance distribution, where drivers tend to exceed the speed limit more regularly than normal. 307 
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The default Desired Speed Distributions are established as part of the Road Class definitions and shall not be 308 

modified.  In specialized cases it may be acceptable to refine the Desired Speed Distributions based on either field 309 

collected data or historical INRIX data; however, approval of this approach will be on a project by project basis 310 

and must be approved by the NCDOT Congestion Management Section. 311 

The use of the Local Segment/Link Parameters Desired Speed Adjustment or Speed Limit signs shall not be utilized 312 

in coding the model unless approved by the NCDOT Congestion Management Section. 313 

Lane Width 314 

It has been observed and well-documented that drivers tend to reduce their speed in narrow lanes.  In other 315 

words, as lateral clearance diminishes, so does a driver's willingness to travel at higher speeds that would 316 

otherwise be acceptable.  The coding of lane widths in TransModeler shall utilize the default width of 12 feet for 317 

all lanes being coded.  On a project by project basis, it may be determined that the additional effort associated 318 

with coding lane widths is critical to adequately evaluate the operations and requires approval from the NCDOT 319 

Congestion Management Section.  If it is determined that lane widths will be modeled, then the lane widths 320 

(rounded to the nearest foot) will be coded for all roadways within the model according to their actual width.  If 321 

the lane widths are modeled, there is no effect on operations in TransModeler for lanes coded as greater than 10 322 

feet; therefore, widths greater than 12 feet should only be modeled as 12-foot lanes. 323 

Grades and Elevations  324 

The grade of a roadway has a direct impact on a vehicle’s ability to accelerate and decelerate and is accounted for 325 

in the model.  The effect of grades and the modeling of elevations needs to be balanced against the level of effort 326 

required to add them to the model.  Three potential options are available and should be determined on a project 327 

by project basis: 328 

 Level 1: No Modeling of Grades and Elevations – Due to minimal variations in topography or the level of 329 

analysis being completed, it is not critical to model the effect of grades on the operations.  Therefore, the 330 

model shall be developed with an elevation and grade of zero for all segments and links. 331 

 Level 2: Modeling of Grades Only – The model shall be developed to include the approximate grade, taken 332 

from an appropriate data source, for each segment within the model; however, it shall not include the 333 

development of a full three-dimensional model that includes elevations for each shape point within the 334 

model. 335 

 Level 3: Modeling of Grades and Elevations – The model shall be developed to include the elevations for 336 

each shape point in the model, based on overlaying the model onto a grid derived from LIDAR data.  The 337 

elevation data shall be reviewed and modified, as needed, to reflect the true elevation of the roadway as 338 

the LIDAR data set removes bridges and major structures from the elevation grid.  The elevation data shall 339 

be set to automatically develop the grades for each segment within the model. 340 

It is also possible that the level of detail for coding grades and elevations in the model may vary between the 341 

existing model data and the proposed design depending on the level of design and shall be determined on a case 342 

by case basis during the scoping of the simulation. 343 

If Level 2 or Level 3 is determined to be the most appropriate level of detail for the model, the profile for each link 344 

shall be reviewed and links shall be split to reflect any changes in grade that are likely to affect the acceleration 345 

and deceleration of vehicles to a level that would affect operations.  The model should also be reviewed for 346 

unfeasible grade changes. 347 
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General Link Coding Best Practices 348 

The model should be developed in a manner that allows for the traffic to be simulated in the most realistic fashion 349 

possible.  In order to facilitate the development of Measures of Effectiveness, improve the optimization of corridor 350 

operations and enhance the driver behavior within the model, the following are best practices that should be 351 

utilized to the greatest extent possible when coding models. 352 

The use of segment breaks should be somewhat minimized, if possible, as vehicles are not allowed to change lanes 353 

while they are traveling on a lane connector, causing slight disruptions in the driver behavior model.  Any locations 354 

with short segment lengths should receive additional review of the vertical elements as there is a tendency to 355 

create short, steep grades, especially if they are modified after they are applied to LIDAR grid data.  The use of 356 

node breaks should be greatly minimized and should only be added to the model where absolutely necessary, 357 

especially in close proximity to intersections where Measures of Effectiveness are being collected.  Any nodes that 358 

are close to intersections should receive additional review of their associated Superlinks to ensure that they are 359 

collecting output data that is reflective of the overall operations of the intersection. 360 

When developing arterial corridors, maximizing the use of two-way links is highly recommended as it allows for 361 

the development of two-way corridor optimization.  Therefore, every effort should be made to code arterials as 362 

two-way links, unless there are compelling reasons to model them as one-way links.  Many of the previously 363 

developed models may include parallel one-way links along arterial corridors and do not require re-coding despite 364 

this recommendation. 365 

The length of lane connectors should be minimized to the greatest extent; however, they should still allow for the 366 

smooth flow of traffic within the simulation.  While there are no firm requirements, it is recommended that lane 367 

connectors connecting segments with the same number of lanes be about five feet in length, while those 368 

connecting an unequal number of lanes (lane drop/lane add) be approximately 25 feet in length, with slightly 369 

longer lengths (up to 40 feet) on freeways.  Again, many of the previously developed models utilized longer lane 370 

connector lengths and may be left alone or revised at the discretion of the analyst and should be determined 371 

during scoping. 372 

The coding of links with tapers on each end of the links results in the link being shown visually without the tapers 373 

and with the full width without the tapering.  This does not affect the operations of the model; however, if there 374 

is a desire to have the model appear visually with the tapers on each side then a segment break can be added at 375 

an appropriate location along the link to visually display the tapers on each end of the link. 376 

Freeway Coding Best Practices 377 

The coding of freeway facilities should be done in a manner that is consistent from project to project, unless there 378 

is compelling evidence that the operations in the field differ from the standard method that freeways are coded 379 

in the model.  The primary areas where guidance is provided on the best practices for coding freeway elements 380 

are freeway merge, diverge and weaving segments and where acceleration and deceleration lanes begin and end. 381 

For existing conditions where an aerial background is being utilized, the merge point (or start of a weaving 382 

segment) for an on-ramp should be coded such that the combined link begins where the pavement marking on 383 

the ramp first intersects the pavement marking on the through lane of the freeway.  The diverge point (or the end 384 

of a weaving segment) for an off ramp should be coded such that the combined link ends at the location where 385 

the pavement marking on the ramp splits from the pavement marking of the through lane of the freeway. 386 
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Sample of Freeway Merge Coding – Existing Conditions 387 

  388 

Sample of Freeway Diverge Coding – Existing Conditions 389 

  390 

For proposed designs, a similar approach should be utilized; however, the use of long spirals in roadway design 391 

makes the process slightly more difficult.  Typically, ramps and loops are 16-20 wide with the alignment being 392 

drawn 12-feet from the outside edge of pavement.  Therefore, at merge locations (or the start of a weaving 393 

segment) for proposed designs, the combined link should begin at the point where the full width of the approach 394 

ramp (or loop) would intersect the edge of pavement for the mainline through lanes on the freeway.  Similarly, 395 

the diverge (or end of freeway weave segment) for the proposed design should end at the point where the full 396 

width of the departing ramp (or loop) would intersect the edge of pavement for the mainline. 397 

Sample of Freeway Merge Coding – Proposed Design 398 

  399 

Segment Begins Segment Begins 
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Sample of Freeway Diverge Coding – Proposed Design 400 

  401 

The coding of acceleration and deceleration lanes should replicate the geometry and traffic movement of the 402 

entering and exiting traffic.  For diverge segments with parallel exits, a lane should be added parallel to the 403 

freeway that allows traffic to move into the lane prior to exiting the freeway.  For angular exits, the model should 404 

be coded without any lanes added to the freeway mainline and traffic exiting directly from the outside freeway 405 

lane.  The segment break for the deceleration lane for parallel exits should begin at the point where the 406 

deceleration lane reaches approximately eight feet in width with the remaining distance upstream coded as a 407 

taper.  Similarly, for an acceleration lane, the segment with the acceleration lane should end at the point where 408 

the lane has tapered down to approximately eight feet in width, with the remaining distance coded as a taper. 409 

For freeway merges in urban areas with higher freeway volumes and greater congestion, it has been observed 410 

that drivers tend to merge sooner than those in rural areas, where congestion is lower.  To better model this, the 411 

Lane Connector Connectivity Bias for the lane connector that is merging into the freeway segment should be 412 

modeled with a value of 0.6 for freeway merges on projects located within the boundaries of an MPO and with a 413 

value of 1.0 (the default value) for all other instances. The modification of the Lane Connector Connectivity Bias 414 

to 0.6 may also be used for merges/lane drops on ramp roadways within an interchange if the interchange is 415 

located within the boundaries of an MPO. 416 

Two-Way Left Turn Lane Coding 417 

TransModeler has the ability to model two-way left turn lanes (TWLTL); however, unless the project is modeling 418 

a substantial number of the access points along the roadway with the TWLTL, they should not be included in the 419 

model.   420 

The modeling of left turn lanes along facilities with TWLTLs should be reviewed in close detail and the left turn 421 

lanes may be extended to allow additional storage along the portion of the roadway that is striped as a TWLTL.  A 422 

left turn lane may be extended if the likelihood of the left turning traffic on the subject lane encountering a vehicle 423 

desiring to make a left turn in the opposite direction is low in the opinion of the analyst.  Left turn lanes should 424 

not be extended beyond any access points along the same direction of the roadway that are estimated to produce 425 

more than 30 entering or exiting vehicles in either peak hour. 426 

Intersection Coding 427 

Intersection Coding Best Practices 428 

The coding of intersections in a consistent manner is a goal that will allow for the most reliable comparison of 429 

alternatives and allow for the re-use of model networks.  The following sections include best practices that should 430 

be adhered to as much as possible when developing intersections within the model. 431 

Segment Ends Segment Ends 
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When coding intersections, lane connectors for each movement should be coded to connect to all receiving lanes 432 

that are likely to be utilized under real world conditions.  For example, an exclusive left turn lane from a side street 433 

onto a six-lane arterial should include lane connectors from the left turn lane to all three of the through lanes 434 

along the arterial. 435 

When coding intersections, the coding of turn lanes should generally match the existing geometry and paint 436 

striping, including the addition of a lane prohibition (shown as a solid white line) between the through lanes and 437 

the turn lane.  Because the NCDOT default compliance rate for the lane prohibitions is set to zero, the coding is 438 

essentially aesthetic and does not affect the simulation of traffic.  Therefore, the coding of the intersection does 439 

not need to include segment breaks where the paint striping changes from solid to dashed.  Note that many of 440 

the models developed prior to September 2016 did not include the solid white line lane prohibitions and may be 441 

left alone or revised at the discretion of the analyst and should be determined during scoping. 442 

In TransModeler, vehicles are not able to change lanes while on a lane connector; therefore, the geometry should 443 

be developed in a manner that minimizes the length of lane connectors through an intersection while still 444 

maintaining the operating features of the intersection.  Care should be given on the outbound roadways at 445 

intersections to code the location where the exiting segment begins to allow for a reasonable radius for right 446 

turning traffic from the adjacent leg while not extending the lane connectors substantially past the intersection. 447 

When coding intersections, an attempt should be made to remove any crossing vehicle paths - where movements 448 

are occurring at the same time (for example, opposing left-turns that run during concurrent phases).  If two 449 

movements with crossing connectors are occurring during the same phase at a signalized intersection, the vehicles 450 

will be shown crossing one another in the simulation.  While this does not affect the results of the simulation 451 

substantially, the goal is to make it as aesthetically accurate as possible while still maintaining the proper 452 

operations.  The Drag Bend Points tool may be used to modify the path of lane connectors to remove crossing 453 

paths.  Additionally, slight changes in the angle of the approach link, especially very close to the intersection, can 454 

change the connector paths to eliminate the crossing connectors.  Due to limitations in how intersections are 455 

coded in the model, (including guidance below for offset and channelized movements) it is allowable to have 456 

crossing connectors, but reasonable attempts to remove the conflicting connectors should be made by the 457 

analyst. 458 

Care should be taken in the modeling process to minimize the use of additional nodes in close proximity to other 459 

intersections as this may affect the model outputs if the Superlinks are not properly defined.  Prior to running the 460 

model, the network should be reviewed to determine that the Superlinks are properly set for any links with short 461 

length, especially those in close proximity to other intersections. 462 

Lane Connector Connectivity Bias 463 

Modification of the Lane Connector Connectivity Bias allows for the analyst to influence the lane utilization of 464 

lanes at intersections.  The driver behavior models in TransModeler account for the dynamics that affect lane 465 

utilization at intersections; therefore, the modification of the Lane Connector Connectivity Bias at intersections 466 

shall not be done without approval by the NCDOT Congestion Management Section. 467 

Modeling Stop Bars and Yield Points 468 

For the modeling of existing intersections that have stop bars that are staggered along an approach, the end of 469 

the link should be coded at the stop bar that is located furthest from the center of the intersection.  The Drag Stop 470 

Bar tool should then be used to move the stop bars forward to the location of the stop bar for each lane that 471 

extends beyond the end of the link.  However, for signalized intersections, if the difference between the stop bars 472 
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exceeds 15 feet then only place the end of the link 15 feet from the stop bar for the through movements as we 473 

want to avoid vehicles stopping between the end of the link and stop bar that are not triggering the detector. 474 

The yield points for permitted movements with conflicting traffic should be reviewed in the model for each 475 

intersection and adjusted using the Drag Yield Position tool such that the vehicles yield at an appropriate location 476 

when waiting for an adequate gap. 477 

Modeling Channelized Movements and Offset Turn Lanes 478 

The modeling of channelized movements that are separated (with either painted or physical islands) require 479 

special attention from a modeling standpoint.  Channelized right turn lanes shall be modeled as part of the same 480 

link as the through traffic and included in the main intersection node unless there is a lane addition on the 481 

receiving approach.  This requirement includes yield controlled movements that do not result in a lane addition 482 

downstream.  The Highway Capacity Manual 2010 does not include any means of determining delay or Level of 483 

Service for yield movements; therefore, yield controlled right turn movements shall be included in the signal 484 

operations.  For yield controlled movements, Right Turn on Red (RTOR) may be used for the right turns to emulate 485 

the yield controlled conditions.   486 

The modeling of offset left turns (those with the left turn separated from the adjacent through lanes to improve 487 

sight distance at the intersection) should be treated in a similar manner and modeled as part of the same link as 488 

the adjacent through lanes.  If the offset left turn is more than 16 feet away from the nearest through lane, then 489 

the analyst may choose to create a separate link for the left turn lane, if they feel it will produce more realistic 490 

operations. 491 

Coding of Turn Bays and Lane Additions 492 

When coding turn lanes, the available storage is often a critical component of the analysis and should be modeled 493 

at a level that allows for the accurate analysis of the operations.  When a lane is added or dropped, it should be 494 

coded such that the link (or segment) begins/ends where the lane reaches approximately eight feet in width with 495 

the remainder length being coded as a taper.  The eight-foot width was selected as it is approximately the width 496 

of a car plus a small amount of lateral clearance and is assumed to be the point where two vehicles can safely pass 497 

each other or queue without interfering with one another laterally. 498 

The use of tapers in TransModeler allows for the model to visually match the actual geometry; however, tapers in 499 

TransModeler are aesthetic in nature.  While a taper may show an increased width as a lane is added or dropped, 500 

vehicles do not utilize the additional lane width within the taper and only one vehicle can occupy a position 501 

laterally along its length.  Therefore, the use of long tapers should be avoided when possible as they do not provide 502 

any additional storage or ability for traffic to pass queued vehicles.  The model should be developed to include 503 

the effective length of the storage on each approach and adding lanes one at a time to model transitions is 504 

desirable.  505 

TransModeler does not draw tapers when lanes are added to the median side of the link or segment; therefore, 506 

no additional coding is required and the lane connectors at the lane addition should not be lengthened 507 

substantially to try to give the appearance of a taper. 508 

Modeling Wide Medians and Two-Stage Crossing 509 

The modeling of wide medians and two-stage crossings at unsignalized intersections can have a noticeable effect 510 

on operations and require special consideration when coding the model.  If the model is coded with a two-stage 511 

crossing but the median width is not wide enough to store a truck, the truck will block through traffic until it finds 512 

a gap.  Conversely, if it is coded as a single node then vehicles must find gaps in both directions of traffic before 513 
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making the turn, causing the side street delay to be much higher than expected.  Therefore, a balance is required 514 

to allow the model to produce realistic results. 515 

If a roadway has a median width greater than 50 feet it should be modeled as a two-stage crossing with nodes 516 

being located on each side of the median and a separate link representing the median refuge area between them.  517 

If the median width is 24-50 feet in width the intersection should be coded in the same manner; however, the 518 

intersections should be coded with a minimum link length of 48 feet by moving the intersection nodes out slightly 519 

to accommodate truck storage within the median link.  For median widths less than 24 feet, it should be coded as 520 

a single intersection node and vehicles must clear both directions of traffic in a single movement to make a left 521 

turn. 522 

Modeling Crosswalks 523 

The modeling of pedestrians at intersections can have a substantial effect on the operation of the model and may 524 

be included in the analysis on a project by project basis.  If it is determined that crosswalks will be included in the 525 

model, they should be added to the network with the Add Crosswalk Tool in the Roadway Editor toolbox.  Once 526 

the crosswalks are added, the end of the link (and any stop bars) should be modified such that they are prior to 527 

the crosswalk. 528 

The modeling of pedestrians requires the creation of a pedestrian volume file (.ped) on the Input tab of the Project 529 

Settings.  The pedestrian volumes should be added to the model using the Edit Pedestrian Volume tool included 530 

in the Edit Intersection toolbox.  Unless there is a compelling reason approved by NCDOT not to, pedestrian 531 

volumes should be included with random arrivals. 532 

Turn Prohibitions 533 

The model being developed shall include all turn prohibitions.  If a single movement is prohibited, then the 534 

prohibition shall be coded by not providing a lane connector for the prohibited movement.  If the prohibition is a 535 

series of movements, such as no through traffic through a shopping center, the prohibition should be coded 536 

utilizing the Turn Prohibition Editor with the turn prohibition file (.bin) being added on the Input tab of the Project 537 

Settings. 538 

Any turn prohibitions in the model shall be detailed in documentation for the model with the justification for the 539 

prohibition. 540 

Signalized Intersection Coding 541 

The coding of signalized intersections in TransModeler requires a basic understanding of signal design and 542 

operations.  Attempts have been made to simplify the coding of signalized intersections and the following section 543 

includes the default values and basic coding requirements for signalized intersections.  More detailed coding of 544 

signalized intersections may be allowable on a project by project basis if they are warranted by the project scope 545 

or the nature of the improvement.  Deviation from the default values shall be discussed with the NCDOT 546 

Congestion Management Section and documented in the model documentation, if approved.  For additional 547 

guidance on the design of signalized intersections, please refer to the NCDOT Traffic Management and Signal 548 

System Unit Design Manual 549 

(https://connect.ncdot.gov/resources/safety/its%20and%20signals%20resources/its%20and%20signals%20unit550 

%20design%20manual.pdf).   551 

The coding of signalized intersections is completed by utilizing the Edit Intersection Control tool in the Intersection 552 

toolbox.  The following sections include the process for coding signalized intersections in the model. 553 

https://connect.ncdot.gov/resources/safety/its%20and%20signals%20resources/its%20and%20signals%20unit%20design%20manual.pdf
https://connect.ncdot.gov/resources/safety/its%20and%20signals%20resources/its%20and%20signals%20unit%20design%20manual.pdf
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Control Type and Configuration 554 

All signalized intersections in TransModeler shall be coded as Traffic Actuated signals and the Actuated Controller 555 

Configuration shall be Type 170.  The main approach that includes phases 2+5 should be selected based on which 556 

roadway is the major roadway and is typically either the Eastbound direction if the East-West route is the major 557 

roadway or Northbound if the North-South route is the major roadway. 558 

Time of Day Plans 559 

The signal input file (.tms) should include timing plans for each simulation period within a given scenario being 560 

modeled. The use of separate AM and PM input files is strongly discouraged.  The Start Time field shall be set such 561 

that it begins either before or at the same time as the simulation project being modeled.  Typically, there should 562 

be a separate signal timing plan for each peak period being modeled.  The signal input file is loaded in the Project 563 

Settings Input tab. 564 

Turns Tab 565 

The turns tab shall be populated (through the use of a turning movement .bin file) for any projects that include 566 

isolated (non-coordinated signals) as they rely on the turn data for optimization.  A single .bin file is preferable 567 

that includes individual fields for each period being simulated. 568 

Timing Tab 569 

The timing tab is where the signal phasing and timing parameters are entered for each signal.  For any existing 570 

signals, the use of the Table of Operations and Phasing Diagram on the existing signal design plans should be 571 

utilized as a basis for determining the phasing for the signal.  In the absence of an existing signal plan, engineering 572 

judgment or the technique described in the Developing Phasing and Timing for New or Modified Signals section 573 

below should be utilized to determine the most appropriate phase settings. 574 

The phase ID’s shall be set based on the NEMA phase numbering system included in the following figure. 575 

 576 
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The phase settings for each of the phase ID’s shall be defined in the Intersection Control Editor Map View Pane.  577 

The movements in the Map View Pane should be set to correct states by right clicking on the arrows to properly 578 

define the green movements as permitted, protected or overlap.  The operations of protected and overlap right 579 

turns are identical in the simulation of the model; however, are accounted for differently when calculating the 580 

deterministic Highway Capacity Manual (HCM) based delay.  Therefore, overlaps shall be categorized correctly 581 

when utilizing deterministic Level of Service measures of effectiveness.  582 

Right Turn on Red (RTOR) 583 

Right Turn on Red (RTOR) shall not be included in the model for modeling of signalized intersections in a future 584 

year analysis, except where explicitly allowed (see below).  Because RTOR are not allowed for the future year, they 585 

should also not be modeled as part of the base year scenario in order to allow for a more reliable comparison of 586 

the results. 587 

The use of RTOR is permitted when coding channelized right turns with yield controlled movements that are being 588 

modeled as part of the signal (see Modeling Channelized Movements and Offset Turn Lanes section for additional 589 

details).  On a project by project basis the use of RTOR for signals that currently allow RTOR and are not modified 590 

as part of the build improvements may be allowed, if approved by the NCDOT Congestion Management Section. 591 

Flashing Yellow Arrow 592 

TransModeler includes the ability to model Flashing Yellow phases; however, the application of the Flashing 593 

Yellow Arrow does not appear to fully replicate the true operations of the phasing technique and is more geared 594 

towards the use of overnight flash than as a means of controlling permitted left-turns.  Therefore, the phasing 595 

should not include flashing yellow for left turns; any left turn movements that include flashing yellow should be 596 

modeled as permitted green movements.  If the left turn movement controlled by a flashing yellow arrow is a 597 

permitted only (not protected/permitted), the permitted green may be added to the corresponding through phase 598 

on the opposite side of the intersection.  For example, a westbound permitted left would typically be included in 599 

Phase 6 (if the east-west route is the major street); however, it could also be added to Phase 2.  This would allow 600 

the permitted left to begin before the through movement on the same approach as is allowed for Flashing Yellow 601 

Arrow operations. 602 

One of the primary advantages of the Flashing Yellow Arrow is that it eliminates the “yellow trap” where drivers 603 

may make a left turn movement as their signal turn transitions to red assuming the opposite direction is 604 

transitioning to red at the same time.  Because of the way TransModeler operates, the unsafe driving behavior 605 

that is exhibited with the yellow trap does not occur; therefore, the use of the permitted green phasing will 606 

adequately address the yellow trap concerns in the modeling of the signal operations. 607 

Timing Settings 608 

The default timing settings in TransModeler are defined in the NCDOT Default Simulation Project file and are 609 

described, along with guidance on how each parameter should be implemented beyond the default setting, in the 610 

following section. 611 

 Coordinate Beginning of _________ 612 

o Default = Green 613 

 Min Green  614 

o Default = 7 seconds 615 

o Modify through movement phases that carry a majority of the traffic on each approach (where 616 

the through movement is higher than the sum of the left-turn, right-turn and u-turn movements) 617 

based on the posted speed along the approach, with 50-55 mph = 14 seconds, 40-45 mph = 12 618 
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seconds and ≤35 mph = 10 seconds.  If a movement meets the criteria for either peak period, both 619 

periods shall include the revised minimum green.  620 

 Maximum Green 621 

o Default = 60 seconds 622 

o Should be modified to fit the actual needs of each phase within the intersection 623 

 Yellow  624 

o Default = 5 seconds 625 

 Red Clearance 626 

o Default = 2 seconds 627 

 Lost Time  628 

o Default = 5 seconds 629 

o Doesn’t affect simulation, but does affect deterministic LOS results 630 

 Recall Mode 631 

o Default = none 632 

o Min recall for minor street through movement phases if a majority of the traffic on the approach 633 

makes the through movement 634 

o Max recall for major street through movements 635 

 Memory Mode  636 

o Default = Non-Locking 637 

 Extension  638 

o Default = 3 seconds 639 

o Modify for through movement phases that carry a majority of the traffic on each approach to 6 640 

seconds 641 

 Simultaneous Gap Out 642 

o Default = Yes 643 

 Added Initial/Actuation 644 

o Default = 2 seconds 645 

 Max Initial 646 

o Default = 30 seconds 647 

 Time before reduction 648 

o Default = 15 seconds 649 

 Reduce by / Every 650 

o Default = 0.5 seconds / 5 seconds 651 

 Min Gap 652 

o Default = 3 seconds 653 

 Coordinated Phases 654 

o Default = No 655 

o Shall be modified to yes for any coordinated phases, typically phases 2+6 656 

 Max Inhibit 657 

o Default = No 658 

o May be modified to Yes for select phases if properly documented in model documentation 659 

 Optimization Minimum Green 660 

o Default = 7 seconds 661 

o Modify to match Min Green settings defined above 662 
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Detector Placement and Settings 663 

The use of detectors, or loops, for signalized, actuated intersections is vital to properly modeling a signal’s 664 

operations.  To simplify the process of developing detectors in TransModeler a default detectors template is 665 

included in the NCDOT Default Simulation Project file, and is located in the Intersection Toolbox Configuration 666 

dialog box. 667 

 668 

The default detector setup for NCDOT signals includes the following: 669 

 Minor Street Approach (Phases 4+8) – Stop bar detection on all lanes and no advance detection 670 

 Major Street Approach (Phases 2+6) – Advance detection on through and shared lanes with stop bar 671 

detection for exclusive right and left turn lanes 672 

The default settings for the detectors include the following: 673 

 Detection set to Call and Extend for all detectors 674 

 Mode set to Presence for all detectors 675 

 Stop bar detector length = 40 feet 676 

 Advance detector length = 6 feet 677 

 Setback distance for Advance detectors = 300 feet 678 

Detectors are added as Sensors in TransModeler by utilizing the Add and Assign Detectors tool on the Intersection 679 

toolbox.  Once the sensors are added based on the above default template, the analyst should remove (using the 680 

“Delete a Sensor Station” tool on the Roadway Editor toolbox) the following detectors: 681 

 Major street (phases 2+6) through and shared through and right 6-foot by 40-foot sensors at the stop bar. 682 

 Minor street (phases 4+8) through and shared through and right/left 6-foot by 6-foot sensors located 300 683 

feet upstream of stop bar. 684 

On a project-by-project basis, the analyst may utilize advanced detector settings if approved by NCDOT, with all 685 

changes included in the model documentation, including: 686 
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 Utilizing the actual detector settings from a signal design plan (typically only for advanced simulations 687 

requiring calibration) 688 

 Modifying the Setback Distance based on approach speed limit 689 

 Adding delay settings to stop bar detectors 690 

 Adding queue or carryover settings for advance detectors 691 

 Modifying default detector assignment for overlap phases 692 

 Modifying the Setback Distance when the link is shorter than 300’ (tight diamonds, etc.) 693 

Pedestrian Timing Settings 694 

If it is determined during scoping that the model will include the analysis of pedestrians at intersections, then the 695 

following settings shall be utilized: 696 

 Pedestrian Links shall be defined in the Map View Pane where a crosswalk will be added and the link 697 

defined in the Ped Links field in the Timings tab 698 

 Pedestrian Walk + Flashing Don’t Walk (W + FDW) shall be defined as: 699 

o W + FDW = 7 seconds + Crossing Width (ft) / 3.5 ft/sec 700 

Ring and Barrier Tab 701 

Once the phases for a traffic-actuated timing plan have been defined, a phase order and transition scheme with a 702 

ring-and-barrier table can be defined as well.  The ring-and-barrier table is a common method for illustrating the 703 

phase transition logic for actuated controllers.  The ring and barrier tab is where the phase order and transitions 704 

are defined in TransModeler. 705 

The block of phases between any two consecutive barriers is referred to as a barrier and the sequence of phases 706 

in a single row – which may span multiple barriers – is referred to as a ring.  Dual ring, two-barrier designs are 707 

common.  However, TransModeler allows more complex designs with as many as 8 barriers and 8 rings. 708 

The ring and barrier for existing signals should be defined based on the Phase Diagram from the existing signal 709 

design plan.  For modified or new signals, the ring and barrier table should be set up based on engineering 710 

judgment and the best practices described in the Signalized Intersection Coding Best Practices. 711 

HCM Adjustments and LOS Tab 712 

TransModeler has the ability to analyze the Level of Service for intersections based on the deterministic LOS 713 

methodologies from the Highway Capacity Manual 2010 (HCM 2010).  The use of deterministic LOS may be 714 

approved by the NCDOT Congestion Management Section on a project by project basis for intersections that have 715 

relatively low volumes and congestion is not a major concern of the project.  In order to fully implement the HCM 716 

methodology, several variables should be input on the HCM Adjustment tab based on the guidelines included in 717 

the NCDOT Congestion Management Section Capacity Analysis Guidelines 718 

(https://connect.ncdot.gov/resources/safety/Congestion%20Mngmt%20and%20Signing/Congestion%20Manage719 

ment/Capacity%20Analysis%20Guidelines.pdf).  Once the turn data field is selected the LOS output will be 720 

calculated on the LOS Tab 721 

Run Yellow Threshold Parameter 722 

One of the parameters that is utilized in TransModeler is the Run Yellow Threshold, which determines whether a 723 

vehicle will enter the intersection during a yellow traffic signal indication, provided that the movement through 724 

the intersection is unimpeded.  If the expected travel time to reach the stop bar at the intersection is less than 725 

this threshold, a vehicle will proceed to enter the intersection.  Otherwise, it will decelerate and prepare to stop 726 

at the stop bar.   727 

https://connect.ncdot.gov/resources/safety/Congestion%20Mngmt%20and%20Signing/Congestion%20Management/Capacity%20Analysis%20Guidelines.pdf
https://connect.ncdot.gov/resources/safety/Congestion%20Mngmt%20and%20Signing/Congestion%20Management/Capacity%20Analysis%20Guidelines.pdf
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Based on the default timing parameters of 5 seconds yellow and 2 seconds red clearance, a default Run Yellow 728 

Threshold of 4 seconds is included in the default parameters file.  This was determined assuming a startup lost 729 

time of 2 seconds for a total of 9 seconds of Yellow, Red Clearance and Startup Loss.  The NCDOT default for Lost 730 

Time is 5 seconds; therefore, a run yellow threshold of 4 seconds would allow for this 5 second value. 731 

If actual signal timings are utilized in the simulation, the default Run Yellow Threshold should be set at 80 percent 732 

of the average yellow time based on the timings for all signals in the model. 733 

Signalized Intersection Best Practices 734 

The phasing and timing settings for signalized intersections require the analyst to review the demand volumes 735 

and simulation to determine the most appropriate signal operations.  Much of the guidance included in the NCDOT 736 

Congestion Management Section Capacity Analysis Guidelines is directly applicable to simulation based studies, 737 

including: 738 

 Signal phasing should remain consistent for all time periods. As an example, if split phasing is used for the 739 

AM peak, it must be used for the PM peak. Changing the phasing sequence, such as altering left-turn 740 

phasing from leading left to lagging left, is dependent on the traffic signal controller equipment. 741 

 Dual Left Turns should be used cautiously due to: 742 

o Turn Conflicts requiring split phasing 743 

o Protected Phasing (see signal plans) 744 

o Driveways in close proximity to the intersection on the receiving lanes can lead to erratic 745 

movements 746 

o Merges on the receiving lanes can create false capacity in the analysis 747 

 Dual Right Turns with one lane sharing a Through movement perform poorly in overlap and Right-Turn-748 

On-Red conditions. 749 

 Through Movements on highway ramps should not be combined with right turns for three phase signals 750 

or standard diamond configurations. The through movement should be shared with the left-turn lanes. 751 

 For analysis of future operations, use protected-only phasing, not protected/permitted phasing. This 752 

analysis will identify the required storage in the event that protected-only phasing is necessary. The use 753 

of protected/permitted phasing for signals not included in the Build design of the project may be allowed 754 

on a case by case basis with approval from the NCDOT Congestion Management Section. 755 

 Intersections with combination through/left-turn lanes should have either permitted-only left-turn 756 

treatment or split phase left-turn treatment for that approach. This is not a recommended geometric 757 

configuration and should be avoided when possible if there is an opposing movement. 758 

 Lane configuration for opposing side streets should match when possible to avoid driver confusion (for 759 

example: avoid a combination through/left-turn and right-turn lane on one approach opposite a 760 

combination through-right-turn and left-turn lane on the opposite approach). 761 

 For analysis, generally use protected left-turn treatment instead of permitted when: 762 

o Dual left-turn lanes are present 763 

o Hourly volume exceeds 240 cars 764 

o Left-turn lanes are crossing 3 or more opposing through lanes of traffic 765 

o When a condition is satisfied in the table below: 766 
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Number of Opposing Lanes  
(Through and Right) Condition 

1 Left-Turn Volume * Opposing Volume > 50,000 

2 Left-Turn Volume * Opposing Volume > 90,000 

3 or more Left-Turn Volume * Opposing Volume > 110,000 

 Use overlapping right-turn phasing where appropriate. Use of a shared through-right turn lane limits the 767 

effectiveness of the right-turn overlap, especially where volumes require dual right turns. 768 

 Cycle lengths for individual intersections in coordinated systems should be equal. Double or half cycles 769 

can be used if the minimum cycle lengths, defined below, are accommodated. 770 

 It should not be the intent at the planning stage of a project to fully design and optimize a coordinated 771 

traffic signal system. 772 

 Generally, the minimum cycle lengths are shown in the table below.  Deviation from these minimum 773 

values is acceptable if justified in the model documentation.  774 

Number of Phases Minimum Cycle Length 

2 60 seconds 

3-6 90 seconds 

7 or more 120 seconds 

 Generally, the maximum cycle length should not exceed 180; however, cycle lengths up to 240 seconds 775 

are acceptable if justified in the model documentation. 776 

It is becoming more common, especially with alternative intersection designs, to have a single signal controller 777 

controlling multiple intersections (nodes).  TransModeler is able to group multiple nodes into a single signal 778 

controller by using the Edit Intersection Control tool on the Intersection toolbox and while holding down the Shift 779 

key, selecting each node that you want grouped together, and then selecting the green checkmark in the Multiple 780 

Intersections dialog. 781 

Developing Phasing and Timing for New or Modified Signals 782 

As stated above, the initial development of the phasing for a signalized intersection should rely on the existing 783 

signal design plan for the intersection.  For intersections that are being modified substantially, or are new 784 

intersections, engineering judgment, in accordance with the above Best Practices should be utilized to develop 785 

the phasing and timing plans.  However, if the analyst is uncertain about what the best timing plan may be, 786 

TransModeler has the ability to develop phasing and timing plans from turning movement data based on a set of 787 

default rules and a template from the Ring and Barrier Table.   788 

To allow TransModeler to develop the Timing and Ring and Barrier data, the intersection turning movements shall 789 

be entered on the Turns tab and all of the phases should be deleted from the Timing tab, leaving the Phases table 790 

empty.  The Optimization tool on the Timing tab can then be selected with the default information for the Timing 791 

Plan set (as described in the Signal Optimization section below).  Three additional tabs are also included for 792 

intersections with no phases defined, including the Phase Sequence, Turn Treatment and Left Turn Rules tabs.  793 

The analyst should review the available Ring and Barrier templates and may experiment with different templates 794 

to determine the best phase sequence for the intersection.  On the Turn Treatment Tab, the Left Turn Treatment 795 

can be defined or set to Rule Based with RTOR set to Prohibited.  The Left Turn Rules tab provides some rules of 796 

thumb for determining when Permitted or Protected Phasing should be utilized.  These rules will provide 797 

reasonable results, but should always be verified against the information provided above in the Best Practices 798 

section.  Once the settings are configured, the OK button can be selected and TransModeler will develop a Timing 799 

Plan and Ring and Barrier based on the options selected.  The LOS Tab can be utilized to test various phasing plans 800 
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by using different Ring and Barriers Templates and the deterministic LOS to determine the best phasing plan for 801 

the intersection.  Note that once the timings are set, additional revisions will be needed on the Timing plan to 802 

match the default settings listed above in the Timing Settings section. 803 

Roundabout Coding 804 

The coding of roundabouts in TransModeler is done by utilizing the Add Roundabout tool in the Road Editor 805 

toolbox.  By using the Add Roundabout tool, the roundabout will be coded with the proper road classes to allow 806 

for the network to properly model the driver behavior of traffic at the roundabout.  If detailed design data is not 807 

available for roundabouts, single lane roundabouts should have an inscribed diameter of 120 feet and multi-lane 808 

roundabouts should have an inscribed diameter of 150 feet, 809 

Roundabouts shall be coded based on their inscribed diameter with a lane width of 12 feet.  Circulatory lane 810 

widths greater than 12 feet shall only be modeled as 12 feet, as the increased lane widths may cause changes in 811 

driver behavior as the maximum speed for a horizontal curve is based on the inside edge of the lane.  If the 812 

roundabout is located along a corridor that includes signalized intersections, the links on each approach should 813 

be maintained as two-way links and not separated into one-way links due to the effect it has on signal optimization 814 

along corridors. 815 

Each roundabout should be drawn with a splitter island on each approach.  For roundabouts with a median width 816 

less than 16 feet, the width of the splitter island should be 15 feet and the length should be 30 feet.  For 817 

roundabouts with a median width of 16 feet or more, the width of the splitter island should be the median width 818 

+ 5 feet, while the length of the splitter island should be twice the width of the splitter island.  Based on the median 819 

width of the approach roadways, the length and width may have to be adjusted for each individual approach, 820 

using the Road Editor, if the approach roadways do not have a uniform median width that allows for all approaches 821 

to be created with the Add Roundabout tool. 822 

The driver behavior for roundabout operations is accounted for in the model through the use of the Roundabout 823 

Road Classes; therefore, the addition of yield signs is not needed for the entry lanes to the roundabout.  Once the 824 

roundabout is coded, the Road Class for the circulatory roadway shall be reviewed and the appropriate 825 

Roundabout Road Class based on the circulatory speed of the roundabout shall be selected. 826 

The coding of the roundabout, especially for multi-lane roundabouts, should be based on the proposed design 827 

with the lane connectors accurately representing the proposed geometry.  For multi-lane roundabouts, because 828 

vehicles cannot change lanes while on a lane connector, care should be given to minimizing the length of lane 829 

connectors within the roundabout to allow for the most realistic operations possible.  Lane change prohibitions 830 

should not be used inside the circulatory area of the roundabout unless special circumstances dictate their use.  831 

In this case, their use should be documented. 832 

The coding of bypass lanes at roundabouts can be accomplished several different ways.  The preferred method 833 

for coding bypass lanes that do not result in an additional lane being added on the downstream roadway should 834 

be to code the bypass lanes as an additional lane within the roundabout.  The preferred method of coding bypass 835 

lanes that add an additional lane on the downstream roadway should be to code them as a separate link outside 836 

of the roundabout with no direct interactions with the roundabout geometry. 837 

The coding of roundabouts in TransModeler also requires a careful review of the network to ensure that the 838 

Superlinks defined are able to accurately collect the delay and queue data at the roundabout approach.  Because 839 

the roundabout tool adds a node at the beginning of the splitter island, it creates a short link approaching the 840 

circulatory roadway.  The delay and queue data on this short link may not accurately be reflected if there is 841 

substantial queueing on the approach.  Therefore, special care should be taken to utilize the Superlink Manager 842 
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to combine Superlinks in a manner that will allow the output to be collected properly.  An example of the coding 843 

of a single Superlink between two roundabouts is shown in the following graphic. 844 

Sample of Superlink Coding at a Roundabout 845 

 846 

Superstreet Coding 847 

The proper coding of Superstreets in TransModeler allows for the accurate modeling of the operations and 848 

optimization of the corridor with full one-way progression.  The preferred method for coding superstreets is to 849 

develop them as one-way links in each direction along a roadway.  For most applications of the superstreet 850 

corridor, utilizing one-way links provides for the most accurate evaluation of the operations.  Therefore, the coding 851 

of links along the main roadway should be as individual one-way links in each direction with the appropriate 852 

median width.  However, if the superstreet intersection is not the primary emphasis of the project and is for an 853 

isolated intersection along a longer corridor with all of the remaining signals being full movement, the analyst may 854 

code it as a two-way link to allow for the two-way optimization of the overall corridor.   855 

The coding of the main intersection should be such that each direction of travel has its own node.  If the main 856 

intersection includes directional left turn lanes from the mainline onto the side street, they should be coded as 857 

separate links with the link beginning at the point where the monolithic island would begin.  Consideration should 858 

be given to adding a segment break and short additional lane on the mainline link in advance of the left turn lane 859 

splitting from the mainline roadway to better model the transition into the left turn storage bay.  If the model 860 

includes movements from the side street directly into u-turn lanes that extend back to the main intersection, the 861 

direct entry u-turn lanes should be coded as part of the main intersection node, but should not have lane 862 

connectors from the mainline through lanes to the direct u-turn lanes.  If pedestrians are included in the model, 863 

they shall be modeled with a standard z-crossing. 864 

The coding of the u-turn locations should include creating a short link between each direction of traffic with either 865 

a stop sign or a signal at the node where the vehicles are turning.  If a traffic control device is not placed on the u-866 

turn link, it will not be possible to collect delay or LOS at the node; therefore, all u-turn nodes must have a traffic 867 

control device defined.  The stop bar and/or yield point should be adjusted to accurately model the location where 868 

vehicles wait to make the u-turn movement. 869 

Diverging Diamond Interchange Coding 870 

The coding of Diverging Diamond Interchanges (DDI) in TransModeler allows for the detailed evaluation of the 871 

operations of the interchange.  The coding of DDIs shall include developing them to a level that incorporates the 872 

design elements that are critical to their operations.  The DDI geometry should be coded in TransModeler with 873 
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reverse curvature upstream of the crossover, with crossover angles between 40 and 50 degrees and a tangent 874 

section through the crossovers. 875 

Because DDIs have slightly different Desired Speed Distributions where vehicles tend to adhere more closely to 876 

the speed limit, specific DDI Road Classes have been developed and shall be utilized along with the design speed 877 

for the DDI itself.  The DDI-specific Road Class should be utilized for the approach links that have the reverse 878 

curvature and the links within the interchange itself. 879 

The coding of the signals for DDIs shall include the use of two controllers with dummy phases being utilized to not 880 

trap vehicles on the link between the crossover and the adjacent signals that control the turn movements on each 881 

side of the interchange. 882 

In the event that pedestrian crossings are included in the model, care should be given to the location of the 883 

crosswalks and stop bars.  Due to the geometry of the DDI, the model frequently includes very long lane 884 

connectors.  Because vehicles cannot change lanes while on a lane connector, the distance added due to the 885 

inclusion of crosswalks may result in traffic movements that do not fully replicate the expected operations within 886 

a DDI.  If this occurs, consideration of extending the stop bars further into the intersection may be acceptable with 887 

proper documentation in the model documentation and approval from the NCDOT Congestion Management 888 

Section. 889 

The coding of the model and how delay and queue length are extracted as part of the output of MOEs should also 890 

be reviewed.  With the DDI configuration, short links are created and proper review of the model to combine links 891 

into Superlinks is critical and allows for the improved accuracy of output data.  Additional guidance on Superlinks 892 

is included in the Measures of Effectiveness section. 893 

Check Network and Check Signal Plan 894 

Following the development of the model and prior to running any output or submitting for review, the analyst 895 

should utilize the Check Network and Check Signal Plan tools to review the model coding.  The following 896 

evaluations should be included in the Network Check: 897 

 Errors in intersection geometry 898 

 Short segments (<10 feet) 899 

 Errors in segment geometry (shape, grade and elevation gaps exceeding 8 feet) 900 

 Missing lane connections 901 

 Invalid Superlinks 902 

 Signalized intersections without timing plans 903 

 Detectors not assigned to any phase 904 

 Node and Segment fidelity errors 905 

It is possible, although rare, that the network check will identify items that are not actually errors.  Therefore, if 906 

after running the network check, it is determined that items are identified that are not actual errors, they should 907 

be documented in the model documentation. 908 

The Check Signal Plan tool (>Project>Intersection Control>Check Signal Plans) should also be run with any non-909 

resolved errors noted in the model documentation. 910 

SIGNAL OPTIMIZATION 911 

The optimization of signalized intersections is vital to accurately modeling the traffic operations of both isolated 912 

signals and coordinated corridors. The optimization of signals in TransModeler is completed in two different 913 
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manners depending on the number of signals being analyzed, with isolated signals (those that are not coordinated 914 

with other signals in a signal system) and multi-signal corridors (those that are coordinated as part of a signal 915 

system) being optimized with separate methods. 916 

The following are recommendations for signal timing and apply to all signalized intersections. 917 

 Generally, the minimum cycle length for a two-phase signal should be 60 seconds, with three to six phase 918 

signals having a minimum cycle length of 90 seconds, and seven or more phases having a minimum cycle 919 

length of 120 seconds.  Deviation from these minimum values is acceptable if justified in the model 920 

documentation. 921 

 Generally, the maximum cycle length should not exceed 180; however, cycle lengths up to 240 seconds 922 

are acceptable if justified in the model documentation. 923 

 Overall cycle lengths should be rounded to the nearest 10 second increment and individual splits should 924 

be rounded to the nearest whole second. 925 

Isolated Signals 926 

If the signal is an isolated signal (not coordinated with another signal) then the Optimize Signal Timings feature 927 

under the Phase Tab of the Intersection Control Editor shall be utilized.   In order to run the optimization process, 928 

the turning movement volumes shall be added to the project settings on the Network Tab.  Once the Optimize 929 

Signal Timings tool is selected, the Flow field shall be set to the turning movement volumes for the period that is 930 

being optimized, typically the peak hour.  The signal optimization shall be run with Webster Equation selected for 931 

the Optimize Cycle option and the minimum and maximum cycle lengths (as described above) included.  The 932 

optimization should be run with the Optimize Split option set to Rule-Based.  If optimization of the leading and 933 

lagging phases is appropriate, then the Optimize Phase Sequence option under Phase Sequence may be selected. 934 

If the optimized cycle length is not an even 10-second increment, then round to the nearest 10 second increment 935 

and re-run the optimization with the rounded value as the fixed cycle lengths.  Once the cycle length is an even 936 

10-second increment, each phase split should be adjusted to the nearest second with the overall cycle length 937 

being maintained. 938 

Multi-Signal Corridors 939 

For projects with multiple signalized intersections that are located along a corridor, the simulation-based signal 940 

optimization tool in TransModeler shall be utilized.  The signal optimization process utilizes the Corridor Toolbox 941 

(>Project>Intersection Control>Corridor Toolbox).  Before initiating the signal optimization process, all Superlinks 942 

along the corridor shall be reviewed to ensure they are accurately collecting the delay and queue data along the 943 

corridor.  The first step in the optimization process is to select the corridor to be optimized by developing a path 944 

beginning at least one node upstream of the first signal being optimized and ending at least one node beyond the 945 

last signal in the corridor.  For corridors with only two-way links, it is not important which direction is selected. 946 

However, if there are any one-way links along the corridor it can only be optimized in one direction; therefore, 947 

the peak direction with the highest volumes should be optimized for each period being optimized.   948 

Once the multi-signal corridor is selected, the optimization shall be completed by setting a warmup period of at 949 

least 5 minutes (increase to 10 minutes if any major route in the network exceeds 3 miles) and evaluation start 950 

and finish times of 8:20-8:50 for the AM peak and 17:20-17:50 for the PM peak.  The Optimize Signal Timings 951 

setting shall be set to Both Directions if all links along the corridor being optimized are two-way links and to One 952 

Direction if any of the links along the corridor are one-way links. 953 
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The cycle length should be optimized with the minimum and maximum cycle lengths (as described above) and 954 

Step being set to 10 seconds.  Under the options tab, the Master Intersection (Offset =0) shall be set with the 955 

Number of Simultaneous Simulations typically being set to Max to minimize run times. 956 

The default weighting in TransModeler tends to produce shorter cycle lengths; however, the trend in North 957 

Carolina tends to be towards longer cycle lengths. Therefore, the Performance Index MOE weighting should be 958 

set to the following to allow the optimization to trend toward higher cycle lengths:  959 

 Control delay=1 960 

 Queue Length=0.5 961 

 Arrival on Green=5  962 

 Stops=0.25 963 

The weighting may be reviewed on a project-by-project basis and modified if the cycle lengths being produced are 964 

not reasonable; however, all scenarios that are being compared shall utilize the same Performance Index MOE 965 

Weights. 966 

The default settings for Offset optimization should also be utilized  967 

 Stage 1  968 

o Step Size=5 seconds 969 

o Number of Steps=6 970 

o Number of Iterations=3  971 

 Stage II  972 

o Step Size=1 second 973 

o Number of Steps=5 974 

o Number of Iterations=6). 975 

The optimized cycle length shall be rounded to the nearest 10 second increment and phase splits should be 976 

rounded to the nearest 1 second.   977 

Best Practices for Signal Optimization 978 

The optimization of signalized intersections requires experience in traffic operations and basic knowledge of signal 979 

design; however, the optimization methods in TransModeler should be considered a tool that assists the analyst 980 

in developing the signal timing and offsets for a given project.  Therefore, fine tuning of the signal optimization is 981 

recommended following the completion of the optimization task in TransModeler.  The simulation should be 982 

reviewed and the operations observed to determine how well the signals are operating.  Utilizing the Create Time 983 

Space Diagram tool from the Corridor toolbox is also a valuable tool in determining how well a corridor is 984 

optimized.  Once the overall network has been reviewed, the analyst may attempt to improve the overall 985 

operations by fine tuning the phasing, timings or offsets, with all changes being reviewed by simulating the model.  986 

Any substantive modifications to the optimized signal phasing, timings or offsets should be described in the model 987 

documentation. 988 

The integration of either half-cycles or double-cycles for individual signals along a coordinated corridor is also 989 

acceptable; however, these options are not available in the standard optimization procedures.  Therefore, an 990 

analyst may choose to utilize half- or double-cycles along a corridor and should optimize their operations through 991 

the use of the Time-Space Diagram and through observation of the model simulation. 992 
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TransModeler does allow for the coordination of individual paths that support major movements, even if they are 993 

not along a defined corridor.  The use of the Corridor Optimization for non-linear paths and the utilization of Time-994 

Space diagrams may be utilized if there are major travel patterns that require coordination that are not along a 995 

linear corridor. 996 

The coordination of grids and other networks where major corridors intersect may include optimizing both the 997 

east-west and north-south routes at the same time, which is possible in TransModeler.  The best way to coordinate 998 

this type of system is to first optimize the major route that includes the coordinated phases, then each 999 

perpendicular route should be reviewed and the cycle length set to the same (or a compatible variation of the) 1000 

major corridor cycle length with each signal’s splits being optimized individually.  Then, the Time Space Diagram 1001 

for the minor roadway corridor should be selected and the green band for the major intersection should be held 1002 

constant with the green bands for the other intersections being moved to manually optimize the coordination 1003 

along the perpendicular route while not affecting the coordination on the major roadway. 1004 

Optimization of Superstreet corridors should be done individually for each direction of travel along the corridor. 1005 

VOLUME INPUT 1006 

The development and input of traffic demand is one of the most important elements of a simulation project. 1007 

Defining traffic demand in TransModeler includes not only the volumes of vehicle trips to be simulated, but also 1008 

the paths vehicles choose to travel to reach their assigned destination. Traffic demand can be specified through a 1009 

variety of methods, such as defining turning movements, origin-destination trip tables, or a specific set of vehicle 1010 

paths. These Guidelines will provide standards for utilizing either Turning Movement Counts (TMC) or Origin-1011 

Destination (O-D) Matrices.  1012 

This version of the Guidelines presents the settings and input parameters required to simulate volumes in the 1013 

model.  Additional research is being developed to determine the best practices for developing volumes and to 1014 

provide guidance on which of the two methods should be used.  In general, smaller projects should not have any 1015 

problem with utilizing TMC data, while larger projects are typically developed utilizing O-D matrices.  Additional 1016 

guidance on selecting the appropriate type and the actual procedure for converting peak hour volume data to O-1017 

D matrices will be included in future versions of these Guidelines. 1018 

One item that needs to be determined during the scoping process for each project is whether or not the volume 1019 

data will be balanced prior to being utilized in TransModeler.  Both the TMC input and the O-D matrix process can 1020 

accommodate unbalanced trips within the volume development stage.  If TMC counts are being utilized and the 1021 

volumes are to remain unbalanced, TransModeler will automatically balance the network through the use of 1022 

sources and sinks along the internal links of the model.  If O-D matrices are being utilized, the O-D development 1023 

process will result in balanced trips as all vehicles have a defined origin and destination.  If it is determined during 1024 

scoping that the network volumes will be balanced prior to being added to TransModeler as TMC data or if the 1025 

network will be balanced prior to the O-D matrix development process, the method utilized for balancing shall be 1026 

included in the model documentation. 1027 

Warm-up Period 1028 

Each simulation shall include a warm-up period prior to outputs being collected that allows the network to have 1029 

background traffic in the network when the analysis period begins.  The Warm-up Period shall be determined to 1030 

be the greater of either 15 minutes or the expected travel time for the longest path within the model, rounded 1031 

up to the nearest five minutes.  The warm-up volumes should be scaled to 70 percent of the peak hour volume 1032 

being modeled for projects located outside the boundaries of an MPO and 85 percent of the peak hour volume 1033 

for projects located within the boundaries of an MPO.  Deviation from the default percentage may be allowed on 1034 
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a project-by-project basis by the NCDOT Congestion Management Section if actual count data demonstrates that 1035 

a different percentage would produce more reasonable results.  Any deviation from the default shall be included 1036 

in the model documentation. 1037 

Turning Movement Count Input 1038 

Utilizing TMC data as a volume input requires that the volumes be added to the TMC input file (.bin file) for each 1039 

intersection or node (such as a freeway merge or diverge) where there is a change in volume.  The NCDOT Default 1040 

Simulation Project file includes a TMC file with the following volume fields: 1041 

 TMC_0745  AM Warm-up Volumes 1042 

 TMC_0800  AM Peak Hour Volumes 1043 

 TMC_1645  PM Warm-up Volumes 1044 

 TMC_1700  PM Peak Hour Volumes 1045 

 1046 

The TMC_0745 and TMC_1645 fields shall include volumes that are 75 percent (or other approved percentage) of 1047 

the corresponding peak hour volume and should be entered as an hourly rate (not factored down to 15-minute 1048 

volumes).  The TMC_0800 and TMC_1700 fields shall include the peak hour volumes entered as hourly rates for 1049 

all nodes within the model. 1050 

The TMC file (.bin file) shall then be added to the Trip Tables section of the Project Settings Input Tab 1051 

(>Project>Settings>Input tab).  The Turning Movement Table Settings should then be set to the following by 1052 

selecting the Trip Table Setting icon on the Input Tab: 1053 

AM Peak PM Peak 

Field Value Field Value 

Contains: Multiple Period Volumes Contains: Multiple Period Volumes 

First Volume Field TMC_0745 First Volume Field TMC_1645 

Num. Periods 2 Num. Periods 2 

Start Time 07:00:00 Start Time 16:00:00 

Interval  60 minutes Interval  60 minutes 

Turning Movement Table Options 

External Link Imbalance Threshold 0 vph 

Scaling Factor 1.00 

Internal Link Sources and Sinks – Imbalance Thresholds 20 vph 

Internal Link Sources and Sinks – Source Start/End Position 50 % / 50% 

Internal Link Sources and Sinks – Sink Start/End Position 50 % / 50% 

Departure Headway Distribution Random (Uniform) 

Once the Trip Tables are set up, the Local Loading Parameters need to be modified to allow for the loading of the 1054 

volumes based on a distribution that emulates a Peak Hour Factor (PHF) of 0.90.  The NCDOT Default Simulation 1055 

Project file includes the NCDOT_TMC distribution for the Trip Departure Time Distributions and shall be utilized 1056 

for projects that include the simulation of TMC volumes.  Therefore, the NCDOT_TMC distribution shall be added 1057 

to the Node data layer for all external nodes within the model.  Note that the Utilization of the Trip Departure 1058 

Time Distributions requires utilizing TransModeler 4.0 Build 6125 or later. 1059 

Origin-Destination Matrix Input 1060 

Utilizing O-D matrices in TransModeler includes loading each trip via an external origin node or centroid and 1061 

assigning it to exit the model at a defined external destination node or centroid.  For each scenario being modeled, 1062 
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two matrices are required; one for the warm-up period, and one for the peak period being modeled.  Both the 1063 

warm-up and peak hour matrices should include the same volumes with the reduced volume during the warm-up 1064 

period being implemented through the use of a scaling factor in the matrix settings. 1065 

O-D matrices are created using the Create Trip Matrix dialog box (>Demand>O-D Matrix>Create Trip Matrix) and 1066 

selecting the Origins and Destinations fields.  Typically, the Origins and Destinations are set to All Boundary Nodes 1067 

(or All Centroids); however, the use of a selection set of nodes or centroids may also be utilized. 1068 

Each matrix that is to be utilized during each scenario is added to the Project Settings on the Input tab under the 1069 

Trip Tables section. 1070 

Once the matrix is created, the matrix settings must be defined.  The following sections describe each Tab on the 1071 

Trip Matrix Settings dialog box. 1072 

Setup Tab 1073 

The setup tab includes the basic parameters describing the O-D matrix, including the time period of the day to 1074 

which the O-D matrix applies and the spacing of vehicles.  The following table provides a summary of the inputs 1075 

that should be utilized for NCDOT peak hour analysis projects. 1076 

 AM Peak PM Peak 

Field _AM_Warmup.mtx _AM.mtx _PM_Warmup.mtx _PM.mtx 

Time Interval: Start Time 07:45:00 08:00:00 16:45:00 17:00:00 

Time Intervals: End Time 08:00:00 09:00:00 17:00:00 18:00:00 

Matrix Unit Hourly Rate Hourly Rate Hourly Rate Hourly Rate 

Time Distribution Constant Over Time Curve-based Constant Over Time Curve-based 

Unit Scaling Factor 0.75 1.00 0.75 1.00 

Standard Deviation 0.000 0.000 0.000 0.000 

Generate Departure 
Headways by 

O-D O-D O-D O-D 

Departure Headway 
Distribution 

Random (Uniform) Random (Uniform) Random (Uniform) Random (Uniform) 

Contents Tab 1077 

A matrix file can contain multiple matrices. The Contents Tab includes the ability to set additional parameters that 1078 

vary by matrix. The default settings for this tab are not typically modified unless vehicle-to-roadside 1079 

communication (VRC) sensors for MOE output or if Vehicle Class matrices are being utilized (see Modeling Heavy 1080 

Vehicles/Vehicle Fleet: Method 3 for additional information).  If VRC sensors are being utilized, the setting for all 1081 

matrices should include the Probe column being set to Yes. 1082 

Paths Tab 1083 

These settings are not typically utilized for NCDOT analysis.  Any use of paths shall require approval from the 1084 

NCDOT Congestion Management Section. 1085 

Curve Tab 1086 

When Curve-based is selected for the Time Distribution setting on the Setup Tab, a Curve Tab is added to the Trip 1087 

Matrix Settings dialog box.  A curve-based time distribution allows discrete time intervals to be created that define 1088 

the variation in rate over time.  For NCDOT projects, the default curve shall be defined to emulate a PHF of 0.90 1089 

with the following percentages assigned to the curve: 1090 
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AM Peak PM Peak 

Begin Time Percentage Begin Time Percentage 

08:00 25.0% 17:00 25.0% 

08:15 27.8% 17:15 27.8% 

08:30 25.0% 17:30 25.0% 

08:45 22.2% 17:45 22.2% 

MODELING HEAVY VEHICLES/VEHICLE FLEET 1091 

The modeling of heavy vehicles and the definition of the vehicle fleet for the simulation can have substantial 1092 

effects on the operations of the model.  TransModeler models heavy vehicles based on a vehicle fleet that defines 1093 

the percentage of each vehicle class that is expected to occur.  As vehicles are generated in the simulation model, 1094 

they are randomly assigned a vehicle class based on the distributions set in the model. 1095 

Three methodologies are available for the modeling of heavy vehicles in TransModeler. The most appropriate 1096 

method shall be determined on a project-by-project basis during the scoping of the project.  The three potential 1097 

methodologies are as follows: 1098 

 Method 1 – Global Vehicle Fleet: The use of a global vehicle fleet should only be used for projects where 1099 

the distribution of trucks is similar for a majority of the roadways being modeled.  This methodology 1100 

utilizes a single distribution of vehicles such that each entry node assigns vehicles based on the same 1101 

distribution of vehicle classes. 1102 

 Method 2 – Local Loading Parameters: The use of local loading parameters allows the analyst to establish 1103 

multiple distributions of vehicle types and then assign them to each entry node.  This method allows for 1104 

the analyst to control the distribution of vehicles entering the model; however, it does not allow control 1105 

of the vehicles once they enter the model.  This method is best for moderate variations in truck volumes 1106 

and where the variations are not expected to substantially affect the operations. 1107 

 Method 3 – Vehicle Class Matrices: The use of individual matrices for each vehicle class (or set of vehicle 1108 

classes) allows the full modeling of vehicles from their origin to their destination.  This method should be 1109 

utilized when there are substantial variations in truck volumes that are expected to effect the operations 1110 

and/or design of a project.  For example, if a freeway has a truck percentage of 12 percent and a y-line 1111 

interchange has a truck percentage of 2 percent, the only way not to have roughly 12 percent trucks on 1112 

the ramps is to utilize matrices for each vehicle class (or set of classes). 1113 

Note that consideration should be given to the actual truck volumes and not just their percentage.  For example, 1114 

a very low volume roadway with a high truck percentage may not produce enough trips in the model to have a 1115 

noticeable effect and the use of Local Loading Parameters (or even Global Parameters) may be acceptable. 1116 

Vehicle Fleet 1117 

The definition of the vehicle fleet in TransModeler will vary depending on the method selected above.  For Method 1118 

1 and 2, the full distribution of vehicle classes shall be utilized, including the assignment of trucks to the vehicle 1119 

fleet.  Method 3 will utilize the NCDOT default vehicle fleet without trucks for the non-truck matrices and each 1120 

truck matrix will be defined based on a truck vehicle class. 1121 

The NCDOT Default Simulation Project file includes a set of vehicle class definitions and a default distribution of 1122 

the non-truck vehicle classes (shaded in yellow in the table below) that are based on manual classification counts 1123 

of traffic throughout North Carolina.  The non-truck vehicle classes include PC1, PC2, PC3, PU, B and M.   1124 

For Methods 1 and 2, the vehicle fleet distributions should be modified based on the percentage of trucks that 1125 

are to be included in the model.  For projects based on a traffic forecast (or other similar work product) the Dual 1126 
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classification is equivalent to the ST vehicle class and the TTST classification is equivalent to the TT vehicle class.  1127 

For peak period analysis, the daily total truck percentage in the traffic forecast (or other similar work product) 1128 

shall be divided by two to determine the truck percentage that shall be modeled in TransModeler. The primary 1129 

reason for dividing the truck percentage by two is that it is assumed that the peak hour includes a high percentage 1130 

of commuter traffic and that trucks tend to avoid peak travel periods when possible. 1131 

Based on the percentage of trucks that are to be modeled, the following table shall be utilized to define the vehicle 1132 

classes for the non-truck vehicles. 1133 

% HV 0.0% 1.0% 1.5% 2.0% 2.5% 3.0% 3.5% 4.0% 4.5% 5.0% 5.5% 6.0% 

PC1 2.0 2.0 2.0 2.0 2.0 1.9 1.9 1.9 1.9 1.9 1.9 1.9 

PC2 45.0 44.5 44.3 44.1 43.9 43.6 43.4 43.2 43.0 42.8 42.5 42.3 

PC3 2.5 2.5 2.5 2.5 2.4 2.4 2.4 2.4 2.4 2.4 2.4 2.4 

PU 50.0 49.5 49.2 48.9 48.7 48.6 48.3 48.0 47.7 47.4 47.2 46.9 

B 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 

M 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 

ST 
0.0 * 1.0 * 1.5 * 2.0 * 2.5 * 3.0 * 3.5 * 4.0 * 4.5 * 5.0 * 5.5 * 6.0 * 

TT 

% HV 6.5% 7.0% 7.5% 8.0% 8.5% 9.0% 9.5% 10.0% 10.5% 11.0% 11.5% 12.0% 

PC1 1.9 1.9 1.9 1.8 1.8 1.8 1.8 1.8 1.8 1.8 1.8 1.8 

PC2 42.1 41.8 41.6 41.4 41.2 41.0 40.7 40.5 40.3 40.0 39.8 39.6 

PC3 2.3 2.3 2.3 2.3 2.3 2.3 2.3 2.3 2.2 2.2 2.2 2.2 

PU 46.7 46.5 46.2 46.0 45.7 45.4 45.2 44.9 44.7 44.5 44.2 43.9 

B 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 

M 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 

ST 
6.5 * 7.0 * 7.5 * 8.0 * 8.5 * 9.0 * 9.5 * 10.0 * 10.5 * 11.0 * 11.5 * 12.0 * 

TT 

% HV 12.5% 13.0% 13.5% 14.0% 14.5% 15.0% 15.5% 16.0% 16.5% 17.0% 17.5% 18.0% 

PC1 1.8 1.7 1.7 1.7 1.7 1.7 1.7 1.7 1.7 1.7 1.7 1.6 

PC2 39.4 39.1 38.9 38.7 38.5 38.3 38.0 37.8 37.6 37.4 37.1 36.9 

PC3 2.2 2.2 2.2 2.2 2.1 2.1 2.1 2.1 2.1 2.1 2.1 2.1 

PU 43.6 43.5 43.2 42.9 42.7 42.4 42.2 41.9 41.6 41.4 41.2 41.0 

B 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 

M 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.3 0.2 0.2 0.2 

ST 
12.5 * 13.0 * 13.5 * 14.0 * 14.5 * 15.0 * 15.5 * 16.0 * 16.5 * 17.0 * 17.5 * 18.0 * 

TT 

* denotes the total truck percentage and should be distributed proportionally based on the traffic forecast distribution 

Method 1 – Global Vehicle Fleet 1134 

The definition of a global vehicle fleet is found in the >Parameters>Vehicle Fleet> Classification>Class> dialog box 1135 

and shall be based on the weighted average of trucks that are to be simulated in the model.  The weighted average 1136 

should be calculated by multiplying the volume on each entry point to the model by the forecast (or other similar 1137 
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work product) truck percentage and then dividing by the total entry volume.  Once the overall weighted average 1138 

is determined, it should be rounded to the nearest one-half percent and the table above shall be utilized to define 1139 

the vehicle class distributions in the vehicle class table.  For projects that include the analysis of multiple scenarios, 1140 

it is preferable to maintain the same distribution for all analysis scenarios, unless there is a substantial change in 1141 

truck percentage forecast among the scenarios.  The distribution of the truck percentage for ST and TT should be 1142 

roughly based on the proportion included in the weighted average. 1143 

Method 2 – Local Loading Parameters 1144 

The definition of Local Loading Parameters is found in the >Demand>Local Loading Parameters>Edit Distributions 1145 

dialog box.  New distributions shall be added by right clicking under the Vehicle Class Distributions heading and 1146 

selecting Add.  A new distribution should be added for each unique heavy vehicle distribution included in the 1147 

traffic forecast (or other similar work product) and generally should be named based on the truck percentage from 1148 

the forecast.  The appropriate distribution of vehicle fleet (assuming the percentage is divided by two) would then 1149 

be selected from the table above and added to the Local Vehicle Class Distribution table.  For example, if the 1150 

forecast has (4,2) listed for the truck percentages, a new distribution name (4,2) would be added and the 1151 

information included under the 3% column above would be added with the ST percentage being set to 2% and 1152 

the TT percentage being set to 1%. 1153 

Once the new Local Loading Parameter vehicle class distributions are defined, they must be assigned to each entry 1154 

node based on the forecast percentages. The next step shall be to add a field to the node (or centroid, depending 1155 

on how the traffic is being loaded onto the model) to assign the Local Loading Parameters to each entry node by 1156 

selecting >Demand>Local Loading Parameters>Apply Distributions.  In the Apply Local Loading Parameters dialog 1157 

box, a new field (typically named VehClassDist) is defined for the Node (or Centroid) layers.  Once the Local Loading 1158 

Parameters field is added to the node (or centroid) layer, the appropriate distribution shall be defined for each 1159 

entry node (or centroid) within the model by utilizing the Dataview feature or by another appropriate method. 1160 

Method 3 – Vehicle Class Matrices 1161 

The utilization of individual matrices for each vehicle class includes disaggregating the overall Origin-Destination 1162 

(O-D) matrix into individual matrices that include each vehicle class (or set of classes).  If the vehicle class matrices 1163 

are utilized, they should include three separate matrices, one for passenger vehicles (PC1, PC2, PC3, PU, B and M), 1164 

one for Dual Trucks (ST) and one for Tractor Trailers (TT).  Combining the truck matrices into a single matrix may 1165 

be acceptable, if approved by the NCDOT Congestion Management Section. 1166 

The definition of vehicle class matrices shall be accomplished by defining multiple matrices on the Contents tab 1167 

of the Trip Matrix Setting dialog box.  The Number of Matrices should be increased to 3 and the Matrix names 1168 

(Passenger, Dual, TTST) shall be defined for the three class matrices.  The Vehicle Class field shall be defined for 1169 

the Dual matrix (select ST) and TTST matrix (select TT) with the Vehicle Class field for Passenger left blank.  By 1170 

leaving the Vehicle Class field blank for Passenger the default vehicle class definition (>Parameters>Vehicle Fleet> 1171 

Classification>Class>) will be utilized for all non-truck trips.  Therefore, the default Vehicle Class distribution 1172 

(shaded in yellow above) with 0% trucks shall be defined in the global parameter settings. 1173 

The development of the individual Vehicle Class matrices should include developing them in a manner that roughly 1174 

replicates the total number of trucks (both Dual and TTST) forecast for the model and provides for reasonable 1175 

routing of the trucks through the network to roughly maintain the forecast truck percentage on individual links. 1176 
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RUN CONTROLS AND SIMULATION SETTINGS 1177 

The process of running the simulation requires that several additional settings be defined.  As described in the 1178 

Project Settings section, each simulation shall include a warm-up period prior to outputs being collected that 1179 

allows the network to have background traffic in the network when the analysis period begins. 1180 

Each simulation model is time-based, meaning that the simulated time span is divided into discrete time steps. 1181 

The vehicle state step size determines the frequency during the simulated time span with which TransModeler 1182 

updates the state of each individual vehicle in the network. The NCDOT Default Simulation Project file includes 1183 

the time step for microscopic simulation being set to 0.1 seconds and shall not be modified. 1184 

The simulation models in TransModeler are stochastic, meaning that they rely on random variables that affect the 1185 

outcome of each simulation, effectively making each run like a single observation from a random sample. Running 1186 

multiple simulations is required in order to satisfy some minimum level of confidence in the average of the model’s 1187 

results.  The NCDOT default minimum number of runs for each scenario shall be ten.  For the majority of projects, 1188 

ten simulation runs should be adequate; however, the analyst shall review the model output data (as described 1189 

in the Measures of Effectiveness section) to determine if the number of runs is adequate.  This current version of 1190 

these Guidelines does not include a firm threshold for determining if ten runs is adequate. But, generally, a review 1191 

of the outputs should show that the standard deviation of the output value should not be greater than 50 % of 1192 

the average value for any critical measure within a highly congested network.  1193 

Each time you run a simulation, TransModeler automatically generates a random seed number with which the 1194 

simulation is randomized. Thus, each run will produce a different outcome, and may be viewed as a single 1195 

observation in a random sample. While developing a model, it is desirable to maintain the same random seed 1196 

numbers throughout the analysis as a means of providing an improved basis of comparison among alternatives.  1197 

Therefore, the default random seed numbers shall be 5, 10, 15, 20, 25, 30, 35, 40, 45 and 50 and shall continue in 1198 

increments of five if additional runs are required. 1199 

DYNAMIC TRAFFIC ASSIGNMENT 1200 

TransModeler uses one of a number of route choice models to decide the path each vehicle takes within the 1201 

modeled network. Route choice decisions are largely a function of the travel time between a trip’s origin and 1202 

destination and are determined based on the user’s generalized cost.  Where tolls are included, the overall 1203 

generalized costs may be used to combine the effects of travel time and tolls on the route choice decision.  1204 

When observed travel times are not available, a simulation-based Dynamic Traffic Assignment (DTA) can be run 1205 

in order to estimate "loaded" (i.e., congested) travel times. The idea behind the simulation-based DTA is that by 1206 

running the simulation from start to finish iteratively and averaging output travel costs with input travel costs 1207 

between each iteration, the network loading will converge toward user equilibrium, where vehicles "learn" from 1208 

prior iterations by choosing better paths in each subsequent iteration/simulation until no vehicle can improve its 1209 

travel time significantly by switching to an alternative path. When this condition is satisfied, User Equilibrium is 1210 

achieved. 1211 

Therefore, with networks that have multiple reasonable paths for drivers to travel between major origins and 1212 

destinations, the use of DTA should be strongly considered.  Without DTA, TransModeler will determine the 1213 

quickest travel time for each route based on the free flow travel time along each link and a set delay based on the 1214 

turn movement type at each node.  For larger networks with multiple route options, this can create problems as, 1215 

in most cases, nearly all of the trips between an origin and destination will take the same path through the 1216 

network.  With all traffic taking the same path, it is common to see substantial delay at key intersections, far 1217 

beyond the nominal delay values included in the initial assignment of traffic.  1218 
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In order to provide for more realistic operations, DTA should be considered for networks that have a substantial 1219 

number of trips that have multiple reasonable route options within the modeled network.  If the modeled network 1220 

is linear in nature with few or no alternative routes being modeled within the analysis network, then DTA provides 1221 

little benefit and should not be included in the analysis.  The decision on whether to utilize DTA should be made 1222 

in consultation with the NCDOT Congestion Management Section during the scoping of the project. 1223 

If it is determined that DTA will be utilized for a project, then it should be utilized for all scenarios being modeled 1224 

to allow for an appropriate basis of comparison of the results of the simulation.  The input criteria for DTA includes 1225 

determining either a convergence criteria or a maximum number of simulation runs for iteration.  The 1226 

convergence criteria are based on the calculation of the relative gap (statistical measure of how much variation 1227 

there is between each simulation run) and looks at the overall model operations.  While the use of relative gap 1228 

does a good job of determining the stability of the network overall, it may not be fully reflective of the stability 1229 

for individual O-D pairs.  Due to this, it has been determined that for NCDOT analysis, a minimum number of 1230 

iterations will be utilized in lieu of the relative gap criteria.  Therefore, the following minimum number of iterations 1231 

should be run, based on the number of intersections in the network: 1232 

 < 9 intersections  25 iterations 1233 

 9-15 intersections  50 iterations 1234 

 16-30 intersections  100 iterations 1235 

 > 30 intersections  determined on a project by project basis 1236 

Note that this is the minimum number of iterations.  Following the completion of the DTA runs, the model shall 1237 

be reviewed in detail to determine that the paths utilized during the simulation are reasonable.  If the paths are 1238 

not reasonable, it is likely that the model has not yet reached equilibrium and additional DTA runs should be 1239 

completed, each time checking the paths to determine that they are reasonable.  When reviewing the simulation 1240 

model following DTA, the best tool for determining if the operations and paths are reasonable is through the use 1241 

of the Path Toolbox (>Demand>Path Toolbox) during the simulation of the model.  The Path Toolbox allows the 1242 

analyst to review the travel time and volume for each potential O-D route within the model. 1243 

The DTA process is run for each scenario utilizing the Simulation Options Toolbox (>Simulation>Options) and 1244 

setting the Run input to Dynamic Traffic Assignment.  The following Dynamic Traffic Assignment Settings shall be 1245 

used: 1246 

 Relative Gap  0.00 1247 

 Maximum Iterations  based on information above 1248 

 First Gap  1 1249 

 Gap Interval  10 1250 

 Interval  15 minutes 1251 

 Path Update Threshold  0% 1252 

 Averaging  Method of Successive Averages 1253 

Under the Configure Assignment Output dialog, the file names for the output should be named based on the 1254 

default naming conventions as follows:  1255 

{TIP or Project No.}_{Analysis Year or Years}_{Scenario}_{Alternative (if applicable)}_{AM or PM}_{Output Type} 1256 

For example:  1257 

 I-0000_2040_Build_Alternative 1_AM_Historic Travel Times.bin 1258 
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 I-0000_2040_Build_Alternative 1_AM_Travel Time Variability.bin 1259 

 I-0000_2040_Build_Alternative 1_AM_Turning Delays.bin 1260 

 I-0000_2040_Build_Alternative 1_AM_Path Flow Table.bin 1261 

 I-0000_2040_Build_Alternative 1_AM_Path Table.pth 1262 

The Options section shall include the Fix Random Seed option not being selected.  The number of routing and 1263 

simulation threads may be set to Max or any number to allow for the run times to be minimized. 1264 

Once the simulation-based DTA has been run, the Historic Travel Times.bin and Turning Delays.bin files shall be 1265 

added to the Routing Tab in the Project Settings dialog (>Project>Settings>Routing tab) in the Travel Time and 1266 

Turning Delay fields, respectively. 1267 

Dynamic Traffic Assignment Best Practices 1268 

The utilization of DTA requires the analyst to make a critical review of the operations within the network in order 1269 

to determine that the routing is reasonable.  There are several best practices to consider when utilizing DTA. 1270 

Because DTA learns from previous iterations, if there are substantial changes in a model network, it is often best 1271 

to re-run the DTA process without travel time or delay files included in the routing tab.  This is referred to as “clean 1272 

DTA” and starts with the free-flow travel times.  The primary reason for running a clean DTA is that it may take 1273 

the DTA process many iterations to unlearn a pattern that is no longer present and optimize towards a better 1274 

solution.  If there are only minor variations in the network, then it is often best to keep the previous travel time 1275 

and delay files when running additional iterations with DTA, as it will preserve the previous efforts and provide a 1276 

better starting basis moving forward. 1277 

If there are several paths that have very similar travel times, it can take DTA many iterations to reach a point of 1278 

equilibrium; therefore, the use of the Path Toolbox and detailed observation of the model is critical to determine 1279 

that the operations have stabilized.  If it is observed that traffic is changing the preferred path frequently 1280 

throughout the simulation, it is an indication that equilibrium has not been reached and that additional iterations 1281 

may be warranted. 1282 

VISUAL VALIDATION 1283 

The development of simulation models in TransModeler is based primarily on the default parameters and 1284 

guidance provided in this document.  However, the default values were developed to attempt to capture average 1285 

driver behaviors for typical North Carolina drivers.  Default settings may not always capture location specific 1286 

operations; therefore, visual validation should be considered as a means of better replicating the real world 1287 

operations.  Further refinement of the model, through calibration, can be undertaken to develop the model to a 1288 

level where it replicates (within a statistical level of certainty) the operations of the actual network.  The following 1289 

are three potential levels of analysis for NCDOT Projects: 1290 

 Level 1 – Default Values: Under this scenario, the default values, parameters and coding guidance shall be 1291 

implemented and no additional modification to the model (beyond standard error checking and quality 1292 

control) will be made. 1293 

 Level 2 – Visual Validation: Under this scenario, the model will first be developed utilizing the default 1294 

values, parameters and coding guidance.  Following the standard error checking and quality control, the 1295 

model will be reviewed visually and compared in a qualitative manner to the observed field operations.  1296 

Changes to model parameters that allow the model to better replicate, in a visual manner, the observed 1297 

field operations can be undertaken, with all modifications documented.  The goal of visual validation is to 1298 

develop a model that reasonably replicates the actual field observed observations. 1299 
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 Level 3 – Calibration: Under this scenario, the process of refining the model to replicate the field 1300 

operations is expanded to include statistical evaluation of the model against field collected data sets to 1301 

determine that the model, within a degree of certainty, is replicating real world operations.  This level is 1302 

reserved for very large projects, typically including freeway operations, and requires a substantial level of 1303 

effort. 1304 

Quality Control and Error Checking  1305 

Quality Control of the model shall also be performed on all models prior to submittal to NCDOT.  A detailed review 1306 

of the model for quality control should be done by an individual with a thorough understanding of TransModeler 1307 

and these Guidelines.  A second, independent review of the model by an individual who has expertise in traffic 1308 

operations but was not involved in the development of the model is also recommended prior to running any 1309 

outputs. 1310 

The process of developing the model includes several review steps, primarily by means of error-checking the 1311 

model, between the initial model development steps and the actual running of the model for outputs.  The FHWA 1312 

Traffic Analysis Toolbox Volume III: Guidelines for Applying Traffic Microsimulation Modeling Software includes 1313 

Chapter 4 which details the steps for Error Checking. 1314 

Error checking involves various reviews of the coded network, coded demands and default parameters. Error 1315 

checking proceeds in three basic stages: (1) software error checking, (2) input coding error checking and (3) 1316 

animation review to spot less obvious input errors. 1317 

Review Software Version/Build - The analyst should review the software website or coordinate with Caliper to 1318 

ensure that he or she is aware of the latest Build of the software.  Caliper regularly updates TransModeler with 1319 

new Builds of the software; however, most of these are minor changes and don’t typically modify key driver 1320 

behaviors.  NCDOT will update the current Build of the software at least twice a year (or more frequently if a major 1321 

change in driver behavior is included in a new Build) and provide information on the current Build being utilized 1322 

on their website.  The analysis should be developed in the current Build being utilized at the time the Notice to 1323 

Proceed for the study is issued.  For projects not requiring calibration, updating to any more recent Build of the 1324 

software is acceptable as long as all output is run in the same Build of the software.  For projects requiring 1325 

Calibration, the Build utilized to calibrate shall be utilized for the entire project unless a change is approved by the 1326 

NCDOT Congestion Management Section. 1327 

Review Input – All of the input data utilized to develop the model should be reviewed in detail, including the: 1328 

 Link and Node network 1329 

 Demand and Vehicle Input 1330 

 Driver behavior and vehicle characteristics. 1331 

Review Animation - Animation output enables the analyst to see the vehicle behavior that the model returns and 1332 

assess the reasonableness of the microsimulation model itself. Running the simulation model and reviewing the 1333 

animation, even with artificial demands, can be useful to identify input coding errors. During this process, the 1334 

analyst would input a very low level of demand and then follow individual vehicles through the network. Abnormal 1335 

vehicle behavior (such as unexpected braking or stops) is a quick indicator of possible coding errors. A three-stage 1336 

process can be followed in reviewing the animation output: 1337 

 Run the animation at an extremely low demand level (so low that there is no congestion). The analyst 1338 

should then trace single vehicles through the network and see where they unexpectedly slow down. These 1339 
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will usually be locations of minor network coding errors that disturb the movement of vehicles over the 1340 

link or through the node. This test should be repeated for several different O-D zone pairs.  1341 

 Once the extremely low demand level tests have been completed, then run the simulation at 50 percent 1342 

of the existing demand level. At this level, demand is usually not yet high enough to cause congestion. If 1343 

congestion appears, it may be the result of some more subtle coding errors that affect the distribution of 1344 

vehicles across lanes or their headways. Check entry and exit link flows to verify that all demand is being 1345 

correctly loaded and moved through the network. 1346 

 Run the animation with an extremely high demand, where the network will break down and the queuing 1347 

behavior can be observed.  Running the network with high volumes, which may be present in the future 1348 

year analysis, is helpful in finding coding errors.  The analyst should hypothesize on where the network 1349 

will breakdown first and how the network will respond to congestion.  After running the simulation, the 1350 

actual operations should be compared to this hypothesis to see if it is operating as expected.  1351 

Understanding how and why a model breaks down under heavy traffic can help to find coding errors and 1352 

improve the operations of the model.  Completing this task fully during the base year analysis can save a 1353 

lot of time as it often eliminates coding errors found when analyzing future year operations that require 1354 

re-running the base year model to correct the issue. 1355 

Level 1 – Default Values 1356 

As described above, the use of the NCDOT default values, parameters and coding guidance shall be implemented 1357 

in developing the model, with no additional modification of parameters.  The model will then be run utilizing the 1358 

default parameters and the outputs for various scenarios can be compared.  At this time, the NCDOT default values 1359 

are still being developed and refined; therefore, not all operations will closely match the actual field operations. 1360 

Level 1 analysis should generally be utilized for the following scenarios: 1361 

 Where there are low to moderate traffic volumes that are not expected to create an over-capacity 1362 

condition or substantial levels of congestion. 1363 

 Where the primary goal is to compare alternative scenarios to one another.  The use of default values 1364 

would allow for a full comparison.  However, the use of only default values may be less reliable for the 1365 

actual design of the facility being analyzed. 1366 

 Where the proposed or future condition does not currently exist or where the future year scenario varies 1367 

substantially from the base year configuration (for example, upgrading an arterial to a freeway). 1368 

Level 2 – Visual Validation 1369 

As described above, visual validation includes modifying parameters within the model to better replicate the real 1370 

world operations observed in the field.  The use of visual validation requires that traffic be observed in the field 1371 

during at least the critical peak period.  The model should be reviewed and parameters adjusted to allow the 1372 

model to better represent the real world conditions.  For projects involving an NCDOT forecast, the model should 1373 

be visually validated to match the worse of the AM or PM peak hours. The current forecast procedure includes 1374 

assuming the AM peak is a mirror image of the PM peak, which is often not true in reality; therefore, validation of 1375 

the worse peak provides the most meaningful results. 1376 

The process of selecting and modifying parameters requires an understanding of how the model operates and the 1377 

relationships of the parameters within the model.  Research into many of these parameters is ongoing and is being 1378 

undertaken in an effort to provide better input as to which are the best parameters to be reviewed and modified.  1379 

Therefore, the threshold for developing visually validated models will be left up to the analysts’ discretion until 1380 

improved guidance is provided. 1381 
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If any of the default parameters are modified, the modification shall be documented in the model documentation 1382 

and the default parameters file (NCDOT_Default_Parameters_Date_Terrain.xml) in TransModeler shall be 1383 

renamed with the _Default_ portion of the file name modified to the TIP or Project Number and the _Date_ 1384 

portion updated to the date of the modification.  For example, if a level terrain model for U-0000 modified the 1385 

default parameters in December 2016, the file would be renamed: NCDOT_U-0000_Parameters_12-1386 

2016_Level.xml 1387 

The following parameters, through a limited amount of research, have proven to be prime candidates for selection 1388 

in visually validating the model: 1389 

 Shifting of the Desired Speed Distribution Curve (>Parameters>General>Desired Speed>).  The default 1390 

distribution (driver population and deviation from speed limit increment) should generally be maintained 1391 

but the actual values in the deviation from speed limit can be shifted up or down. 1392 

 Maximum Turning Speed (>Parameters>Vehicle Fleet>Performance>Maximum Speed>Intersection>).  1393 

Modifying the turning speeds at intersections can increase or decrease the saturation flow at the 1394 

intersection. 1395 

 Headway Threshold and Buffer (>Parameters>Driver Behavior>Acceleration>Headway>Thresholds or 1396 

Buffers).  Modifying this parameter affects the spacing between vehicles and the threshold between 1397 

emergency braking, following regime and free flow regime. 1398 

 Discretionary Lane Changing Behavior (>Parameters>Driver Behavior>Lane Changing>Discretionary 1399 

(DLC)>Neighboring Lane Model> Lane Choice Utility Function>), including: 1400 

o Path Influence Factor 1401 

o Heavy Vehicle Ahead 1402 

o On-Ramp Ahead 1403 

o Off-Ramp Ahead 1404 

o Weaving Influence 1405 

 Mandatory Lane Changing Behavior, (>Parameters>Driver Behavior>Lane Changing>Mandatory 1406 

(MLC)>Critical Distance> General Fleet>) 1407 

 Stopped Gaps (>Parameters>General>Microscopic Parameters>Stopped Gaps) controls the spacing of 1408 

vehicles when queued.  This parameter can increase saturation flow rate at intersections if increased 1409 

slightly, but tends to have an opposite effect on freeways discharging from queues during congestion. 1410 

 Lane Connector Connectivity Bias.  This may be modified for freeway merges only to increase the 1411 

likelihood of a vehicle merging onto the freeway earlier. 1412 

The range of reasonable values for which parameters can be modified is not well understood at this point and 1413 

additional evaluation of a parameter’s sensitivity is being reviewed and will be included in future revisions to 1414 

these Guidelines.  Generally, constraining any variation between halving and doubling the value is a good rule of 1415 

thumb for the limits of what is a reasonable modification to parameters. 1416 

Level 3 – Calibration 1417 

The process for developing calibrated models is typically reserved for projects that require additional precision in 1418 

the evaluation of alternatives.  Projects involving the modification of Interstate highways and their interchanges 1419 

typically require calibration as part of the Interchange Access Report (IAR) required by FHWA.  The goal of 1420 

calibration is to develop a model that is able to reproduce, within a reasonable margin, actual field-collected data.  1421 

At this time, additional research is needed before a NCDOT standard can be established for calibration thresholds.    1422 
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MEASURES OF EFFECTIVENESS 1423 

The purpose of computing one or more traffic performance Measures of Effectiveness (MOE) is to quantify the 1424 

achievement of a project's traffic operations objectives and to compare alternatives against one another.  The 1425 

selection of MOEs should be driven by the project objectives and the NCDOT performance standards for the facility 1426 

being modeled.   1427 

The selection of MOEs for any analysis is critical, especially as the FHWA Traffic Analysis Toolbox cautions against 1428 

the use of LOS in comparing simulation results to the Highway Capacity Manual (HCM) derived results. It notes 1429 

that the analyst needs to review the software documentation to understand the differences and to be sure that 1430 

the microsimulation software is calculating LOS properly. Based on a review of the TransModeler documentation 1431 

and discussions with the software developer, Caliper, NCDOT feels comfortable that the software appropriately 1432 

presents the LOS results in a manner that is consistent with the HCM 2010 methodologies. However, to be clear 1433 

that there is a difference between the empirically derived HCM methodologies and those derived through 1434 

simulation, “LOSS” is being utilized to denote that the LOS is a simulation based LOS result.  1435 

Several additional considerations must be evaluated when determining how to interpret simulation based MOEs.  1436 

According to the FHWA Traffic Analysis Toolbox, the analyst needs to determine if the alternatives should be 1437 

evaluated based on their average predicted performance or their worst case predicted performance.  Typically, 1438 

the worst case predicted performance is determined based on a calculation of the 95th percentile result. 1439 

Additionally, the HCM 2010 methodologies are based on an analysis of the peak hour of the day, with a further 1440 

adjustment to the peak 15-minute period within the peak hour for the analysis.  NCDOT has determined that the 1441 

most appropriate application for LOSS shall include extracting the data in one-hour increments and applying the 1442 

following formula (taken from Section 6.3.3 of the FHWA Traffic Analysis Toolbox, Volume III) to determine the 1443 

95th percentile worst result: 1444 

95%Worst Result = m + 1.64 • s  1445 

where: 1446 

m = mean observed result in the model runs 1447 

s = standard deviation of the result in the model runs 1448 

In general, there are four types of MOEs that may be generated for a simulation project, including: 1449 

 System or Network Wide MOEs 1450 

 Corridor MOEs 1451 

 Uninterrupted Flow MOEs 1452 

 Interrupted Flow MOEs 1453 

During the scoping of the project, the potential MOEs described in the following sections should be reviewed and, 1454 

based on the objectives of the project, a set of appropriate MOEs shall be selected. 1455 

System or Network Measures of Effectiveness 1456 

System or network level MOEs are collected for the entire network being modeled for a prescribed time period 1457 

and provide measures of the overall system performance.  The following are potential outputs that may be 1458 

selected based on the objective of the project: 1459 

 Number of Trips - Total number of trips in a given time period 1460 

 Trip Length - Total travel distance averaged over all vehicles  1461 

 VMT - Vehicle miles traveled; the sum total distance traveled by all vehicles  1462 
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 VHT - Vehicle hours traveled; sum total travel time experienced by all vehicles  1463 

 Average Speed - Travel speed averaged over all vehicles  1464 

 Delay - Total difference between experienced travel time and free flow travel time, summed over all 1465 

vehicles  1466 

 Average Delay - Total difference between experienced travel time and free flow travel time, averaged 1467 

over all vehicles  1468 

 Stopped Time - Total stopped time experienced by all vehicles  1469 

 Average Stopped Time - Total stopped time experienced during a trip averaged over all vehicles  1470 

 Number of Stops - Total number of stops experienced by all vehicles  1471 

 Average Stops - Total number of stops experienced during a trip averaged over all vehicles  1472 

For each selected MOE, the average and 95th Percentile Worst Result for all simulation runs (minimum of ten 1473 

model runs) shall be calculated and reported for the one-hour peak period simulated. 1474 

Corridor or Route Measures of Effectiveness 1475 

There are several MOEs that can provide output for individual corridors or specific routes within a model network.  1476 

This type of MOE is beneficial for comparing alternatives and to show the change in travel time or speed along 1477 

corridors or defined routes.  The following Corridor or Route based MOEs may be selected based on the objective 1478 

of the project: 1479 

 Travel Time – travel time along a corridor or between select points in a model.  Several methods may be 1480 

utilized to extract this data from the model output. The preferred methods include either utilizing the 1481 

Trips Statistics O-D Matrix output or a VRC Sensor Matrix.  It may also be acceptable for less complex 1482 

networks to utilize Flow & Travel Time output data for each link and aggregate the data for a corridor or 1483 

route.  The method of travel time output should be determined during the scoping process 1484 

 Average Speed – average speed along a corridor or between select points in model.  Average speed is 1485 

collected in the same manner as travel time as they are closely related.  The same method utilized for 1486 

travel time shall be utilized for average speed. 1487 

 Segment Speed – average speed along each segment (or combination of segments) along an 1488 

uninterrupted flow facility based on the Flow & Travel Time output from TransModeler.  Segment speed 1489 

should not be utilized for interrupted flow facilities. 1490 

 Planning Time Index (PTI) – The planning time index along a corridor or between select points in a model 1491 

is a measure of the travel time reliability.  The planning time index is calculated by dividing the 95th 1492 

Percentile Travel Time by the Free Flow Travel Time with the idea that a PTI of 1.0 is ideal.  The 1493 

determination of the Travel Time shall utilize the same method as was utilized for Travel Time above.  The 1494 

Free Flow Travel Time is a simulation based Free Flow Travel Time calculated in the same manner that is 1495 

based off of running the model with a low volume that creates free flow conditions along the corridor. 1496 

The low flow volumes are developed by scaling the O-D matrices back to a level where it is free flow, but 1497 

care should be given that there are at least 50 vehicles completing each route to ensure a level of statistical 1498 

validity. 1499 

For each selected MOE, the average and 95th Percentile Worst Result for all simulation runs (minimum of ten 1500 

model runs) shall be calculated and reported for the one-hour peak period simulated. 1501 

Heat Maps 1502 

The use of heat maps that display the results along a corridor visually haven proven to be beneficial in conveying 1503 

results to non-technical staff and the public.  Consideration should be given, especially on projects with 1504 
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controversial elements or an elevated interest by the public, to developing heat maps of corridor statistics (travel 1505 

time, speed, LOSS, etc.) to convey the model outputs.  Heat maps should be developed to graphically, through a 1506 

color coded theme transitioning from green to red, convey the information.  Heat maps will likely include an 1507 

increment of less than one-hour (with fifteen minutes as the recommended increment) and should utilize the 1508 

average results (as opposed to 95th Percentile Worst Case) for all runs with increments less than one hour. 1509 

Uninterrupted Flow Measures of Effectiveness 1510 

There are several MOEs that can be utilized to provide output for uninterrupted flow facilities, including freeways, 1511 

multilane highways and two-lane highways.  The use of uninterrupted flow MOEs for multilane and two-lane 1512 

highways should not be utilized along corridors that include signal spacing of less than 2 miles or for facilities with 1513 

a significant presence of on-street parking, heavily used bus stops, or significant pedestrian activity. 1514 

Freeway Facilities 1515 

The evaluation of MOEs for freeway facilities shall include determining the density and corresponding LOSS of each 1516 

segment along the freeway.  TransModeler will segment the freeway facility, if properly coded with freeway and 1517 

ramp road classes, based on the methodology included in the HCM 2010 Chapter 10 (Freeway Facilities) into Basic 1518 

Freeway Segments, Ramp Merge/Diverge Segments and Freeway Weaving Segments.   1519 

The threshold between LOS E and F for Ramp Merge/Diverge Segments and Freeway Weaving Segment is when 1520 

the demand exceeds the capacity of the facility.  In a microsimulation model, capacity is essentially a model 1521 

output, not an input; therefore, determining when a segment exceeds capacity requires additional in-depth 1522 

analysis of the operations.  TransModeler has a methodology for determining if the segment is over capacity; 1523 

however, with the aggregation of data across multiple runs, determining this is much more difficult.  Due to the 1524 

difficulty in determining this threshold, NCDOT has decided to utilize the density of 45 pc/mi/ln as the upper limit 1525 

of LOSS E, with any value exceeding it being reported as LOSS F, which is consistent with the definition for Freeway 1526 

Facilities included in Chapter 10 of the HCM. 1527 

In TransModeler, at each merge or diverge segment, a 1500-foot influence area is determined to calculate the 1528 

density.  For merge or diverge areas that include less than 1500 feet of acceleration or deceleration length, 1529 

TransModeler will create what is known as a Partial Basic Segment that includes the calculation of the density for 1530 

the segment outside of the merge or diverge influence area.  When developing outputs, the results should be 1531 

aggregated together and reported in a manner consistent with HCM 2010 Chapter 10.  TransModeler will 1532 

aggregate the results for multiple segments that make up a single Basic Freeway Segment; however, it does not 1533 

aggregate data for partial basic segments into the overall basic freeway segment.  Therefore, the density for Basic 1534 

Freeway Segments that include partial basic segments shall be calculated based on a weighted average of the 1535 

densities according to each segments total length. 1536 

The density, and corresponding LOSS, shall be reported as the 95th Percentile Worst Result for all simulation runs 1537 

(minimum of ten model runs) and shall be calculated and reported for the one-hour peak period simulated. 1538 

Multilane Highways  1539 

The evaluation of multi-lane highways in TransModeler is implemented based on the methodologies presented in 1540 

Chapter 14 of the HCM 2010.  The primary measure for Multilane Highways is the density along each segment and 1541 

the corresponding LOSS and is collected utilizing the Flow & Travel Time output with the Multilane Highway Level 1542 

of Service group. 1543 

The density and corresponding LOSS, shall be reported as the 95th Percentile Worst Result for all simulation runs 1544 

(minimum of ten model runs) and shall be calculated and reported for the one-hour peak period simulated. 1545 
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Two-lane Highways 1546 

The evaluation of Two-lane Highways in TransModeler is based on the Percent Time Spent Following for each 1547 

facility based on the Two-Lane Highway Class.  The three classes of Two-Lane Highways are defined as follows: 1548 

 Class I two-lane highways are highways where motorists expect to travel at relatively high speeds. Two-1549 

lane highways that are major intercity routes, primary connectors of major traffic generators, daily 1550 

commuter routes, or major links in state or national highway networks are generally assigned to Class I. 1551 

These facilities serve mostly long-distance trips or provide the connections between facilities that serve 1552 

long-distance trips. 1553 

 Class II two-lane highways are highways where motorists do not necessarily expect to travel at high 1554 

speeds. Two-lane highways functioning as access routes to Class I facilities, serving as scenic or 1555 

recreational routes (and not as primary arterials), or passing through rugged terrain (where high-speed 1556 

operation would be impossible) are assigned to Class II. Class II facilities most often serve relatively short 1557 

trips, the beginning or ending portions of longer trips, or trips for which sightseeing plays a significant 1558 

role. 1559 

 Class III two-lane highways are highways serving moderately developed areas. They may be portions of a 1560 

Class I or Class II highway that pass through small towns or developed recreational areas. On such 1561 

segments, local traffic often mixes with through traffic, and the density of unsignalized roadside access 1562 

points is noticeably higher than in a purely rural area. Class III highways may also be longer segments 1563 

passing through more spread-out recreational areas, also with increased roadside densities. Such 1564 

segments are often accompanied by reduced speed limits that reflect the higher activity level. 1565 

The Two-Lane Highway Class, Percent Time Spent Following, and corresponding LOSS, shall be reported as the 1566 

95th Percentile Worst Result for all simulation runs (minimum of ten model runs) and shall be calculated and 1567 

reported for the one-hour peak period simulated. 1568 

Interrupted Flow Measures of Effectiveness 1569 

The evaluation of MOEs for interrupted flow facilities is primarily based on the delay, LOSS and queue length at 1570 

each intersection within the model network.  The data included in the following sections shall be included for all 1571 

intersections within the model network.  The output shall be arranged in a reasonable manner such that allows 1572 

for an orderly review.  In general, the network should be presented along each corridor from west to east and 1573 

from south to north along the corridor.  The outputs should also be labeled based on the cardinal directions 1574 

(Northbound, Eastbound, Southbound and Westbound) unless there is justification for varying from this 1575 

requirement.  For reporting purposes, the approaches of the intersection should be ordered beginning in the 1576 

Southbound direction, continuing clockwise (Southbound, Westbound, Northbound then Eastbound) while 1577 

movements at each intersection should be listed from left to right in the direction oriented toward the intersection 1578 

(for example: WB Left, WB Through then WB Right).  During simulation it is possible that individual movements 1579 

may not always include any volume during the simulation. Movements with zero volume shall not be listed with 1580 

zero delay (zero queue length or as LOSS A) nor be removed from the analysis.  Instead, any movement that reports 1581 

zero volume shall be noted with “N/A” for all of the reported MOEs and an appropriate note stating that no 1582 

volumes were simulated for the given movement.  In TransModeler, the definition of lane groups varies from the 1583 

definition used by other software packages.  Lane Groups are defined for each unique movement or set of 1584 

movements.  For example, an approach with a left/through, through, through/right and exclusive right lane would 1585 

have a total of four lane group corresponding to each unique configuration.  All output should be developed to 1586 

the lane group definition applied by TransModeler. 1587 
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Queue Lengths 1588 

The reporting of queue length shall be done utilizing both the Lane Queue output and the Spillback Queue output 1589 

in TransModeler.  The Lane Queue output shall report the Queue Length and the Spillback Rate for each lane 1590 

group within each intersection, unless the lane is at an unsignalized intersection and does not have any conflicting 1591 

movement.  The Spillback Queue output shall report the Maximum Spillback Queue Length by Approach for each 1592 

approach to an intersection.  All Queue Length calculations shall be based on the 95th Percentile Worst Result for 1593 

all simulation runs (minimum of ten model runs) and shall be calculated and reported for the one-hour peak period 1594 

simulated.  The Queue Spillback Rate shall be based on the average of the Spillback Rate for all of the simulation 1595 

runs (minimum of ten model runs) and shall be calculated and reported for the one-hour peak period simulated.   1596 

For the analysis of Build designs, the length of turn bays should generally accommodate the 95th percentile queue 1597 

length reported at the lane group level.  If the 95th percentile queue length cannot be accommodated in the design, 1598 

justification shall be included in the model documentation. 1599 

Signalized Intersections 1600 

In addition to the Queue Length, the Control Delay by Intersection and Control Delay by Lane Group and their 1601 

corresponding LOSS shall be reported for the overall intersection and each individual lane group.  The Control 1602 

Delay calculations shall be based on the 95th Percentile Worst Result for all simulation runs (minimum of ten model 1603 

runs) and shall be calculated and reported for the one-hour peak period simulated.   1604 

Unsignalized Intersections (Stop or Yield Controlled) 1605 

In addition to the Queue Length, the Control Delay by Lane Group and their corresponding LOSS shall be reported 1606 

for any individual lane group that has a conflicting movement.  The Control Delay calculations shall be based on 1607 

the 95th Percentile Worst Result for all simulation runs (minimum of ten model runs) and shall be calculated and 1608 

reported for the one-hour peak period simulated.   1609 

Note there is not an overall LOSS for unsignalized intersections in the HCM methodology; therefore, overall 1610 

Intersection Control Delay or LOSS shall not be reported for unsignalized intersections.  There is currently no 1611 

methodology for determining the control delay or LOS for yield controlled movements (with the exception of 1612 

roundabouts); therefore, for those in close proximity to signals, they shall be modeled as part of the signal (as 1613 

noted in the Intersection Coding section).  For yield controlled intersections that are not in close proximity to a 1614 

signalized intersection, Queue Length shall be reported for each yield controlled approach with a note that delay 1615 

and LOS are not reported for yield controlled intersections. 1616 

Roundabouts 1617 

In addition to the Queue Length, the Control Delay by Lane and their corresponding LOSS shall be reported for 1618 

each approach lane to a roundabout. The Control Delay calculations shall be based on the 95th Percentile Worst 1619 

Result for all simulation runs (minimum of ten model runs) and shall be calculated and reported for the one-hour 1620 

peak period simulated.   1621 

Urban Street Segments and Facilities 1622 

NCDOT adopted a Complete Streets policy in July 2009 and published the NCDOT Complete Streets Planning and 1623 

Design Guidelines in July 2012.  The NCDOT Congestion Management Section is in the process of determining how 1624 

to best implement the Complete Streets Guidelines and the HCM 2010 methodology for Urban Street Segments 1625 

and Facilities.  Future versions of these Guidelines will include additional guidance on how these principles will be 1626 

applied to NCDOT traffic operations studies. 1627 
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Interchange Ramp Terminals and Alternative Intersection Designs 1628 

The HCM 2010 includes a specific methodology for evaluating interchange ramp terminals and the forthcoming 1629 

6th Edition of the HCM will include methodologies on evaluating Alternative Intersection Designs.  Until these 1630 

methodologies are reviewed in finer detail in TransModeler, those types of treatments should be analyzed as 1631 

individual intersections.  Future versions of these Guidelines will include additional guidance on how these 1632 

principles will be applied to NCDOT traffic operations studies. 1633 

Best Practices for Developing Measures of Effectiveness 1634 

The proper configuration of Superlinks is critical to ensuring that the output MOEs are collected and that the delay 1635 

and queue lengths reported are consistent with those in the simulation model.  All networks shall be thoroughly 1636 

reviewed to ensure that the Superlinks settings are properly configured to extract the output correctly. 1637 

The utilization of Selection Sets in TransModeler is an extremely effective tool that both assists in the extraction 1638 

of data and amount of time it takes to run the simulation.  A thorough understanding of how to utilize selection 1639 

sets in the development of MOE outputs is highly recommended. 1640 

TECHNICAL DOCUMENTATION 1641 

Technical documentation of traffic analysis shall consist of a report, with appendices as necessary, along with a 1642 

listing and justification of any default parameters that were adjusted for the project.  In the future, a sample 1643 

technical report will be provided as a go-by. But in the interim, technical reports should consist of the following 1644 

sections: 1645 

1. Executive Summary – Provide a brief summary of project purpose, results for each analysis scenario, and 1646 

any recommendations made. 1647 

2. Project Background – Briefly describe the purpose of memo and project description. 1648 

3. Description of Scenarios Analyzed – Provide a description of each scenario analyzed.  1649 

4. Methodology – Describe the methodology for the microsimulation, including the TransModeler (or 1650 

TransModelerSE) release version and build number.  A brief description of the visual validation that was 1651 

conducted and any anomalies may be included here.  Also state whether previous TransModeler models 1652 

were used to develop this analysis and, if so, the pertinent information of that model (date, project, 1653 

software version, etc.). 1654 

5. Measures of Effectiveness – Provide a description of the measures of effectiveness (MOEs) selected for 1655 

the project.  The MOEs to be provided are detailed in these guidelines. 1656 

6. Volume Development–Provide a description of volume development methodology and any 1657 

unconventional treatment to the development of volumes. 1658 

7. Deviations from Default Values – Provide a list of any default values that were modified in the analysis, 1659 

including a brief justification for the deviation. Approval of the deviations shall be included in an Appendix 1660 

to the report. 1661 

8. Base Year No-Build Analysis – Provide a description of Base Year No-Build scenario and analysis results, 1662 

including any notable concerns that arose during visual validation. 1663 

9. Future Year No-Build Analysis–Provide a description of Future Year No-Build scenario and analysis results, 1664 

including any notable concerns that arose during visual validation. 1665 
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10. Future Year Build Analysis–Provide a description of Future Year Build scenario and analysis results, 1666 

including any notable concerns that arose during visual validation.  If multiple build alternatives were 1667 

analyzed, include description and results for each. 1668 

11. Base Year Build Analysis (if applicable)–Provide a description of Base Build scenario and analysis results, 1669 

including any notable concerns that arose during visual validation.  Also include illustrations of the signal 1670 

timings used for each intersection in each peak period.  If multiple build alternatives were analyzed, 1671 

include description and results for each. 1672 

12. Conclusions and Recommendations – Provide a brief description of the conclusions and any 1673 

recommendations developed based on the analysis results.  Discuss any counterintuitive results.  1674 

The following tables should be provided in the technical report: 1675 

1. Base Year No-Build Measures of Effectiveness 1676 

2. Future Year No-Build Measures of Effectiveness 1677 

3. Future Year Build Measures of Effectiveness (include tables for each build alternative analyzed) 1678 

4. Base Year Build Measures of Effectiveness, if applicable (include tables for each build alternative analyzed) 1679 

The following figures should be provided in the technical report or appendices of the technical report: 1680 

1. Project and Model Study Area (distinguish between the project study area limits of the analysis model) 1681 

2. Base Year No-Build Volumes 1682 

3. Base Year No-Build Laneage 1683 

4. Base Year No-Build MOEs 1684 

5. Future Year No-Build Volumes 1685 

6. Future Year No-Build Laneage 1686 

7. Future Year No-Build MOEs 1687 

8. Future Year Build Volumes (for each build alternative) 1688 

9. Future Year Build Recommended Laneage (for each build alternative) 1689 

10. Future Year Build MOEs (for each build alternative) 1690 

11. Base Year Build Volumes (if applicable) 1691 

12. Base Year Build Recommended Laneage (if applicable) 1692 

13. Base Year Build MOEs (if applicable) 1693 

SUBMITTAL REQUIREMENTS 1694 

The following items should be included in a submittal package: 1695 

 A completed Submittal Checklist, with justification given for anything not included in the submittal 1696 

package.   1697 
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 Archived models following the naming convention outlined in the File Naming Conventions section.  The 1698 

following settings should be verified in the model before the archive zip folder is created: 1699 

o Turn off all labels 1700 

o Turn off all color themes 1701 

o Make all selection sets inactive 1702 

 MOE Spreadsheets 1703 

 Technical Documentation  1704 

For review purposes, a printable digital copy of the report/documentation submittal is preferable, although 1705 

NCDOT may require hard copies as well.  The number of hard copies will be determined during the scoping process 1706 

of each project.  For plan sheets, such as site plans, the digital submittal should be legible and to scale when 1707 

printed as a 22”x34” sheet.  Use of the Portable Document Format (PDF) is preferred. 1708 

CALIBRATION 1709 

This section will be developed in a future version of these Guidelines. 1710 

MULTI-HOUR SIMULATION MODELS 1711 

This section will be developed in a future version of these Guidelines. 1712 

TRAFFIC IMPACT ANALYSIS 1713 

This section will be developed in a future version of these Guidelines. 1714 

  1715 
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ATTACHMENT A – MODIFICATIONS TO DEFAULT TRANSMODELER FILES 1716 

TransModeler Preferences (tsm_user.xml) 1717 

The following revisions were made to the default file: 1718 

>Display Options>Feature Sizes>Centroids>Radius changed to 50 ft. 1719 

>Display Options>Lane Markings and Medians>Turning Movement Arrows>Setback changed to 40 ft. 1720 

>Display Options>Pedestrian Crosswalks>Color>Empty changed to color #2 (white) 1721 

>Display Options>Minimum Scales> Turning Movement Arrows changed to 1:4000 1722 

>Display Options>Other Options>Default Background Color changed to color #75 (dark grey) 1723 

>Default Project Settings>Simulation Start Time changed to 07:45 1724 

>Default Project Settings>Warm-up period changed to 15 minutes 1725 

>Default Project Settings>Show Optional Settings>Routing Settings for Simulation Route Choice selected 1726 

>Default Project Settings>Show Optional Settings>Project and Model Parameters selected 1727 

>Default Project Settings>Output Options>Report Start Time set to 08:00 and End Time set to 09:00 1728 

>Default Project Settings>Options>Travel Time and Delay> Enforce Free Flow Travel Time as Minimum selected 1729 

>Default Project Settings>Options>Travel Time and Delay> Enforce Global Penalties as Minimum selected 1730 

>Default Project Settings>Assignment>Maximum Number of Iterations set to 50 1731 

>Default Project Settings>Assignment>Convergence set to 0.0001 1732 

>Road Editor>Parameters>Other>Automatically Update Segment Elevation Based Elevation selected 1733 

>Road Editor>Options>Transparent Links and Segments selected 1734 

>Road Editor>Options>Fade Background changed to 25% 1735 

>Intersection Control Editor>Phase Design>Controller Type changed to Type 170 1736 

TransModeler Parameters (NCDOT_Default_Parameters_09-2016_Terrain.xml) 1737 

The following revisions were made to the default file: 1738 

>General>Model Mechanics>Geometry>Turn Capability>Maximum Vehicle Length Allowed for U-turn changed to 1739 

200 feet 1740 

>General>Desired Speed>Distribution> Modified based on following Table: 1741 

Deviation from Speed Limit (mph) % of Driver Population 

Level Rolling Mountainous Freeway Standard High 
Compliance 

Low 
compliance 

-10 -7.5 -5 0.5 1 1 1 

-5 -2.5 0 9.5 9 14 9 

0 2.5 5 25 20 40 15 

5 7.5 10 30 30 30 25 

10 12.5 15 25 30 10 30 

15 17.5 20 9.5 9 4 15 

20 22.5 25 0.5 1 1 5 
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>General>Desired Speed>Lane Adjustments>Lane Speed Factors>   Modified based on following Table: 1742 

Number of 
Lanes 

Lane 1 (Left) Lane 2 Lane 3 Lane 4 Lane 5+ (Right) 

1 1.00     

2 1.03 0.98    

3 1.03 1.00 0.97   

4 1.05 1.02 0.99 0.97  

5 or more 1.06 1.03 1.00 0.98 0.96 

>Vehicle Fleet>Classification>Class> Modified based on following Table for passenger car only distribution: 1743 

Percentage Name Description 

2.0 PC1 High Performance Passenger Car 

45.0 PC2 Middle Performance Passenger Car 

2.5 PC3 Low Performance Passenger Car 

50.0 PU Pickup Trucks, vans, and SUVs 

0.2 B Buses 

0.3 M Motorcycles 

>Vehicle Fleet>Size>Vehicle Size by Class > Changed TT settings to 43 ft. min, 55 ft mean length to correspond 1744 

with WB-50 dimensions 1745 

>Vehicle Fleet>Appearance>Vehicle Appearance by Class> Changed TT Line 2 to blank to remove double trailers 1746 

>Vehicle Fleet>Attributes>Vehicle Attributes by Class> Changed PCE based on HCM 2010 (Exhibit 11-10) by Terrain 1747 

Classification 1748 

Class 
Passenger Car Equivalent (PCE) 

Level Terrain Rolling Terrain Mountainous Terrain 

PC1 1.00 1.00 1.00 

PC2 1.00 1.00 1.00 

PC3 1.00 1.00 1.00 

PU 1.00 1.00 1.00 

ST 1.50 2.50 4.50 

TT 1.50 2.50 4.50 

B 1.50 2.50 4.50 

M 1.00 1.00 1.00 

>Vehicle Fleet>Performance>Maximum Speed>Intersection> Changed values based on following table: 1749 

Mass (lbs) Left U-turn Left Slight Left Straight Slight Right Right Right U-turn 

3307 12 18 40 55 40 12 6 

>Driver Behavior>Roundabouts>General>Priority Belongs to> Changed to Inside Lane 1750 

>Response to Traffic Control>General>Traffic Signals>RTOR Allowed in Right Most Lane Only> unchecked selection 1751 

>Response to Traffic Control>General>Traffic Signals>Run Yellow Threshold> changed to 4.0 seconds 1752 

>Response to Traffic Control>Compliance Rates>Lane Change Rules (General)> changed to 0.0 1753 

>Pedestrian Crosswalk>Walk Time>Walk Duration>Walk Speed (ft/s)> changed to 3.5 per MUTCD 1754 

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Min Green> changed to 7 seconds 1755 
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>Traffic Control Defaults>Timing>Default>Default Phase Settings>Added Initial/Actuation> changed to 2 seconds 1756 

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Extension> changed to 3 seconds 1757 

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Min Gap> changed to 3 seconds 1758 

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Time Before Reduction> changed to 15 seconds 1759 

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Time to Reduce> changed to 0.5 seconds 1760 

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Max Green> changed to 60 seconds 1761 

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Yellow> changed to 5 seconds 1762 

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Memory Mode> changed to non-locking 1763 

>Traffic Control Defaults>Timing>Default>Allow Right Turn on Red> unchecked selection  1764 

>Traffic Control Defaults>Timing>Optimization>Minimum Green> changed to 7 seconds 1765 

>Traffic Control Defaults>Timing>Optimization>Yellow> changed to 5 seconds 1766 

>Traffic Control Defaults>Timing>Optimization>Maximum Cycle Length> changed to 180 seconds  1767 
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ATTACHMENT B – MODEL DEVELOPMENT 1768 

NCDOT Default Road Class Table 

ID Facility Type Speed Limit Desired Speed 

Distribution 01 Freeway 70 Freeway 

02 Freeway 65 Freeway 

03 Freeway 60 Freeway 

04 Freeway 55 Freeway 

05 Freeway 50 Freeway 

11 Directional Ramp 60 High Compliance 

12 Directional Ramp 55 Standard 

13 Directional Ramp 50 Standard 

14 Ramp 45 Standard 

15 Ramp 40 Standard 

16 Ramp 35 Standard 

17 Loop 30 High Compliance 

18 Loop 25 High Compliance 

19 Loop 20 High Compliance 

21 Arterial 65 Standard 

22 Arterial 60 Standard 

23 Arterial 55 Standard 

24 Arterial 50 Standard 

25 Arterial 45 Standard 

26 Arterial 40 Standard 

27 Arterial 35 Low Compliance 

28 Arterial 30 Low Compliance 

29 Arterial 25 Low Compliance 

31 Collector 60 Standard 

32 Collector 55 Standard 

33 Collector 50 Standard 

34 Collector 45 Standard 

35 Collector 40 Standard 

36 Collector 35 Standard 

37 Collector 30 Low Compliance 

38 Collector 25 Low Compliance 

39 Collector 20 Low Compliance 

41 Local 55 High Compliance 

42 Local 50 High Compliance 

43 Local 45 High Compliance 

44 Local 40 High compliance 

45 Local 35 High Compliance 

46 Local 30 High Compliance 

47 Local 25 Standard 

48 Local 20 Standard 

49 Local 15 Standard 

51 Roundabout 25 High Compliance 

52 Roundabout 20 High Compliance 

53 Roundabout 15 High Compliance 

54 Roundabout 10 High Compliance 

61 Arterial_DDI 45 High Compliance 

62 Arterial_DDI 40 High Compliance 

63 Arterial_DDI 35 High Compliance 

64 Arterial_DDI 30 High Compliance 

65 Arterial_DDI 25 High Compliance 

66 Arterial_DDI 20 High Compliance 

  1769 
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LINKS 1770 

NCDOT Congestion Management Section website –  1771 

https://connect.ncdot.gov/resources/safety/Pages/Congestion-Management.aspx 1772 

 NCDOT Default TransModeler database (current version: NCDOT_Default_09-2016.zip)  1773 

 NCDOT Default Project Preferences file (tsm_user.xml) 1774 

 NC OneMap Web Map Layer settings files (NCOneMap(Latest)High.xml and NCOneMap(Latest)Low.xml) 1775 

 NCDOT Default Road Class Definitions (NCDOT Default File 09-2016 Road Class Definitions.xml) 1776 

NC OneMap Aerial Photography –  1777 

http://data.nconemap.gov/geoportal/catalog/raster/download.page  1778 

NCDOT Functional Classification Map - 1779 

http://ncdot.maps.arcgis.com/home/webmap/viewer.html?layers=029a9a9fe26e43d687d30cd3c08b1792 1780 

NCDOT Congestion Management Guidelines - 1781 

https://connect.ncdot.gov/resources/safety/Congestion%20Mngmt%20and%20Signing/Congestion%20Manage1782 

ment/Capacity%20Analysis%20Guidelines.pdf  1783 

NCDOT Traffic Management and Signal Safety Unit – Design Manual 1784 

https://connect.ncdot.gov/resources/safety/its%20and%20signals%20resources/its%20and%20signals%20unit%1785 

20design%20manual.pdf  1786 

https://connect.ncdot.gov/resources/safety/Pages/Congestion-Management.aspx
http://data.nconemap.gov/geoportal/catalog/raster/download.page
http://ncdot.maps.arcgis.com/home/webmap/viewer.html?layers=029a9a9fe26e43d687d30cd3c08b1792
https://connect.ncdot.gov/resources/safety/Congestion%20Mngmt%20and%20Signing/Congestion%20Management/Capacity%20Analysis%20Guidelines.pdf
https://connect.ncdot.gov/resources/safety/Congestion%20Mngmt%20and%20Signing/Congestion%20Management/Capacity%20Analysis%20Guidelines.pdf
https://connect.ncdot.gov/resources/safety/its%20and%20signals%20resources/its%20and%20signals%20unit%20design%20manual.pdf
https://connect.ncdot.gov/resources/safety/its%20and%20signals%20resources/its%20and%20signals%20unit%20design%20manual.pdf
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